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  Editorial

  Welcome to another issue of Full Circle.


  T


  here's no Python or Blender tutorials this month. I've stepped in to fill the Blender space with a GIMP article on using the Prespective Clone tool. For the Python space I thought I'd throw in a quirky article I was sent on how to set up dcm4che. It's a piece of software used in P.E.T. scanning machines in the medical field. I love receiving articles like this as it shows us a side of Linux that we rarely get to see. So, if you're in a field of work which uses Linux, and is something that most people never see, send us an article. The quirkier the better!

  

  My recent gaming addiction (which has taken over from Euro Truck Simulator 2) is X-Plane 10. I bought a MAD CATZ FLY5 joystick and have taken to the (virtual) skies and written a review of X-Plane this month. There's a lot to learn, but it's a great simulation. Also this month in gaming there's a review from Oscar on The Witcher 2.

  

  For the tinkerers out there I'm plodding along with Arduino, while Charles is messing around with Kodi (formerly known as XBMC), and we're on to part two of the Kernel series.

  

  No one wrote to me this month so I'm afraid there's no Letters page. No questions on security means that's also out this month. I believe these are also my last two desktop screens.

  

  Anyway, that's enough rambling from me. Enjoy the issue, and write in!

  

  All the best, and keep in touch!

  

  Ronnie

  ronnie@fullcirclemagazine.org


  News
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  IBM doubles down on Linux


  Less than a year after their announcement that they planned to invest a billion dollars in the Linux platform, IBM continues to ramp up their Linux play by rolling out Linux on Power System servers across 54 of the IBM Innovation and Client Centers worldwide. This comes almost two years after IBM announced that they had ported Linux to the Power Server platform.

  

  The new services, announced last week at LinuxCon North America, are designed to get customers up and running on the Power Server environment while keeping their options open in terms of Linux flavor and applications. Support and training is now available to developers to build applications that can make use of the virtualization and parallel processing features of the Power Systems servers using Canonical Ubuntu Linux, Red Hat Enterprise Linux, and SUSE Enterprise Server.

  

  Source: http://www.zdnet.com/ibm-doubles-down-on-linux-7000033088/

  Submitted by: Arnfried Walbrecht

  


  Ubuntu 14.10 (Utopic Unicorn), Beta 1 preview: No big changes


  Every year by about this time, with the release of the first beta, most Ubuntu commentators have already filed their final story on Ubuntu x.10 for the desktop—well in advance of the final release in October. This time around, with the upcoming release of Ubuntu 14.10 (Utopic Unicorn) for the desktop, the mediasphere is surprisingly quiet on the subject, and there's not much news coming out of Canonical. Mark Shuttleworth's recent blogposts are all about the cloud friendliness of Canonical's products, and so far have nothing to say about the new desktop release.

  

  Jono Bacon's blog, usually a helpful information source, no longer applies, since Bacon left Canonical and his post as Ubuntu community manager at the end of May to become senior director of community at XPRIZE. Until a replacement for Bacon is announced, the four-person Ubuntu community team will bridge the gap.

  

  Like the rest of the industry, Canonical seems to be focusing the majority of its development resources on smartphones and tablets, with the desktop version of Ubuntu now taking something of a back seat.

  

  Source: http://www.zdnet.com/ubuntu-14-10-utopic-unicorn-beta-1-preview-no-big-changes-7000033019/

  Submitted by: Arnfried Walbrecht

  


  5 tips on migrating to open-source software


  Open source is not just for Linux. Yes, you'll certainly find a much larger selection of open-source software for the Linux platform, but both Windows and Apple also enjoy a good number of titles. Regardless of what Free Open Source Software (FOSS) you need to use, you might not always find it the most natural evolution—especially when you've spent the whole of your career using proprietary software. The thing is, a lot of open-source software has matured to the point where it rivals (and sometimes bests) its proprietary counterpart.

  

  With that in mind, I wanted to offer up my five best tips for migrating from a closed-software ecosystem to an open one. This may mean you're just dropping Microsoft Office for LibreOffice—or you might be diving into deeper open-source waters and migrating from Windows to Linux. No matter the change you are about to make, these tips should make the transition easier.

  

  Source: http://www.techrepublic.com/article/5-tips-on-migrating-to-open-source-software/

  Submitted by: Arnfried Walbrecht

  


  Linux servers turned into bots by 'IptabLes' and 'IptabLex' malware


  A botnet that infects and exploits poorly-maintained Linux servers has been used to launch a spate of large DDoS attacks targeting DNS and other infrastructure, Akamai’s Prolexic division has warned.

  

  Dubbed the ‘IptabLes and IptabLex botnet’, the attack targets versions of Apache Struts and Tomcat, as well as some running Elasticsearch that have not been patched against a clutch of vulnerabilities.

  

  Once compromised, the attack elevates privileges to allow remote control of the server from which the malicious code is dropped and run, after which it awaits direction by the bot’s command and control. The binary is connected to two hardcoded addresses running on China Telecom, while anyone whose server has been infected will probably notice poor performance.

  

  Source: http://news.techworld.com/security/3543420/linux-servers-turned-into-bots-by-iptables-and-iptablex-malware/

  Submitted by: Arnfried Walbrecht

  


  What Docker Is—and Is Not


  Docker software has been getting quite a bit of attention recently, because it holds out the promise of making it possible for a developer to develop an application, package it into a container, and then deliver it to a number of different platforms—without having to test every combination of versions of the operating system, database, application framework or development tool. The goal is to overcome all differences in the versions of the operating system, database engines and other tools to make re-hosting an application very easy.

  

  Although Docker indicates that this is a new idea, it really can be seen as a form of application virtualization. Docker relies on a form of processing virtualization, operating system virtualization and partitioning that has become a standard part of the Linux kernel.

  

  Source: http://virtualizationreview.com/articles/2014/09/05/what-docker-is-and-is-not.aspx

  Submitted by: Arnfried Walbrecht

  


  Kinivo releases a pair of inexpensive Linux-friendly USB wireless adapters


  Nowadays, if you buy a laptop, it will have a built-in wireless card (desktops; not always). For the most part, these integrated cards work well -- on Windows. You see, most manufacturers build their machines with only Windows in mind. If you use only Microsoft's operating system, you should be golden. However, for nerds who like Linux (including myself), nonexistent or problematic wireless drivers can be an absolute nightmare.

  

  This is why I recommend a USB wireless adapter to every Linux user; you never know when you may need it as a permanent or temporary internet solution. Unfortunately, not all USB adapters work with Linux out of the box, so the model you choose matters. Today, Kinivo releases two USB wireless adapters that are promised to work with Linux-based operating systems.

  

  Source: http://betanews.com/2014/09/08/kinivo-releases-a-pair-of-inexpensive-linux-friendly-usb-wireless-adapters/

  Submitted by: Arnfried Walbrecht

  


  City of Turin decides to ditch Windows XP for Ubuntu and €6m saving


  €6m: the amount the municipality of Turin hopes to save over five years by switching from Windows XP to Ubuntu Linux in all of its offices.

  

  The move will mean installing the open source operating system on 8,300 PCs, which will generate an immediate saving of roughly €300 per machine (almost €2.5m altogether, made up from the cost of Windows and Office licences)—a sum that will grow over the years as the need for the renewal of proprietary software licences vanishes, and the employees get used to the new machines.

  

  Or rather, to the old ones. Another reason for the switch was that the computers Turin uses are quite old, and installing Windows 8 would have probably been too demanding for them, whereas Linux offers more flexibility with more mature machines. And, as the support for Windows XP officially ended this year, sticking with Microsoft didn't make much sense to Turin. The switch to Ubuntu was officially approved in early August and is expected to take around a year and a half to complete.

  

  Source: http://www.zdnet.com/city-of-turin-decides-to-ditch-windows-xp-for-ubuntu-and-6m-saving-7000033482 /

  Submitted by: Arnfried Walbrecht

  


  Torvalds says he has no strong opinions on systemd


  Linux creator Linus Torvalds is well-known for his strong opinions on many technical things. But when it comes to systemd, the init system that has caused a fair degree of angst in the Linux world, Torvalds is neutral.

  

  "When it comes to systemd, you may expect me to have lots of colourful opinions, and I just don't," Torvalds told iTWire in an interview. "I don't personally mind systemd, and in fact my main desktop and laptop both run it”.

  

  Source: http://www.itwire.com/business-it-news/open-source/65402-torvalds-says-he-has-no-strong-opinions-on-systemd

  Submitted by: Sam Varghese

  


  Everything You Need to Know About Meizu MX4, the Upcoming Ubuntu Phone – Gallery


  The new Ubuntu Touch operating system from Canonical will power the new Meizu MX4 phone and it will be out in December, according to the latest information posted by the Chinese company. We now take a closer look at this new phone to see how it will hold up with an Ubuntu experience.

  

  Canonical hasn't provided any kind of information about a timetable for the launch of the new Ubuntu phone from Meizu, and even the information that we have right now has been posted initially on an Italian blog of the Chinese company. Basically, no one is saying anything officially, but that's not really the point.

  

  The new Meizu MX4 was announced just a couple of weeks ago and many Ubuntu users have asked themselves if this is the phone that will eventually feature the upcoming Ubuntu Touch. It looks like that is the case, so we now take a closer look at this powerful handset.

  

  Source: http://news.softpedia.com/news/Everything-You-Need-to-Know-About-Meizu-MX4-the-Upcoming-Ubuntu-Phone-458882.shtml

  Submitted by: Silviu Stahie

  


  Curl Exploits Closed in All Supported Ubuntu OSes


  Canonical has announced that a couple of curl vulnerabilities have been found and fixed in its Ubuntu 14.04 LTS, Ubuntu 12.04 LTS, and Ubuntu 10.04 LTS operating systems.

  

  The developers have released a new update for the curl package and it looks like a number of security issues have been corrected.

  

  “Tim Ruehsen discovered that curl incorrectly handled partial literal IP addresses. This could lead to the disclosure of cookies to the wrong site, and malicious sites being able to set cookies for others,” reads the security notice.

  

  Source: http://news.softpedia.com/news/Curl-Exploits-Close-in-All-Supported-Ubuntu-OSes-458899.shtml

  Submitted by: Silviu Stahie

  


  Mozilla Thunderbird 31.1.1 Lands in Ubuntu


  Canonical has shared some details about a number of Thunderbird vulnerabilities identified in its Ubuntu 14.04 LTS and Ubuntu 12.04 LTS operating systems, and the devs have pushed a new version into the repositories.

  

  The Thunderbird email client was updated a couple of days ago and the new version has landed pretty quickly in the Ubuntu repos. This means that it should be available when users update their systems.

  

  For example, “Abhishek Arya discovered a use-after-free during DOM interactions with SVG. If a user were tricked into opening a specially crafted message with scripting enabled, an attacker could potentially exploit this to cause a denial of service via application crash, or execute arbitrary code with the privileges of the user invoking Thunderbird,” reads the announcement.

  

  Source: http://news.softpedia.com/news/Mozilla-Thunderbird-31-1-1-Lands-in-the-Ubuntu-458664.shtml

  Submitted by: Silviu Stahie

  


  Stephen Hawking Talks About the Linux-Based Intel Connected Wheelchair Project


  Intel has revealed a new, interesting concept called the Connected Wheelchair, which takes data from users and allows people to share that info with the community and is powered by Linux.

  

  When people say Intel, they usually think about processors, but the company also makes a host of other products, including very cool or useful concepts that might have some very important applications in everyday life.

  

  The latest initiative is called the Connected Wheelchair and the guys from Intel even convinced the famous Stephen Hawking to help them spread the word about this amazing project. It's still in the testing phases and it's one of those products that might show a lot of promise but never go anywhere because there is no one to produce and sell it.

  

  Source: http://news.softpedia.com/news/Stephen-Hawking-Talks-About-the-Linux-Based-Intel-Connected-Wheelchair-Project-458539.shtml

  Submitted by: Silivu Stahie

  


  Lobbying for open source and Linux in schools


  About eight years ago, I started lobbying to bring more Linux and open source software to high schools and higher IT vocational institutions in the Netherlands and Belgium. Here's how I did it and what you can learn from it to do the same where you live.

  

  First, Linux and open source in education can be categorized into three topics:

  1. The infrastructure of schools

  2. The desktop students and teachers work with

  3. The curriculum for IT education

  

  The first topic, the infrastructure at schools consists of a bunch of different software, which is used for administration. Examples are applications like student management systems, document management systems, and operating systems. Basically, this software isn’t that different from what is used in other industries. This applies not only to vocational education, but to all schools at any level.

  

  Source: https://opensource.com/education/14/9/teachers-linux-open-source-education

  Submitted by: Arnfried Walbrecht

  


  The True Measure of a Successful Open Source Project


  A question I get a lot is, “What makes an open source software project successful?” This isn’t a simple question, as every project is really different. But certainly there are some common characteristics: a vibrant and open community and ecosystem of contributors, an innovative goal or technology and investments from a diverse set of stakeholders are just a few.

  

  Business benchmarks and market share help measure the success of a project over time. A blockbuster like Linux can tout nine code changes per hour, $10.8 billion in shared R&D investment, and millions of developers. It runs 65 percent of smart mobile devices, 95 percent of high performance computing market, 55 percent of the embedded systems market, and most of world’s stock exchanges. But there is another measure of success that is extremely powerful: inspiring someone to think, to question, to imagine.

  

  Source: https://opensource.com/education/14/9/teachers-linux-open-source-education

  Submitted by: Arnfried Walbrecht

  


  ChromeOS vs Linux: The Good, the Bad and the Ugly


  Anyone who believes Google isn't "making a play" for desktop users isn't paying attention. In recent years, I've seen ChromeOS making quite a splash on the Google Chromebook. Exploding with popularity on sites such as Amazon.com, it looks as if ChromeOS could be unstoppable.

  

  In this article, I'm going to look at ChromeOS as a concept to market, how it's affecting Linux adoption and whether or not it's a good/bad thing for the Linux community as a whole. Plus, I'll talk about the biggest issue of all and how no one is doing anything about it.

  

  When folks ask me if ChromeOS is a Linux distribution, I usually reply that ChromeOS is to Linux what OS X is to BSD. In other words, I consider ChromeOS to be a forked operating system that uses the Linux kernel under the hood. Much of the operating system is made up of Google's own proprietary blend of code and software.

  

  So while the ChromeOS is using the Linux kernel under its hood, it's still very different from what we might find with today's modern Linux distributions.

  

  Source: http://www.datamation.com/open-source/chromeos-vs-linux-the-good-the-bad-and-the-ugly-1.html

  Submitted by: Arnfried Walbrecht

  


  Netflix support is officially making its way to Linux, finally


  Linux users, you've been very, very, very, very, very, very patient. And now, your patience is being rewarded with Netflix support on your OS of choice. For the longest time Netflix relied on Microsoft's would-be Flash competitor Silverlight. But, of course, support for the plug in was practically non-existent on the open-source OS. Now, with Silverlight fading, and Netflix embracing the power of HTML5, your wish of watching flicks in your favorite distro (be it Ubuntu, Mint or Arch) may finally come true. Paul Adolph from Netflix posted a message to Ubuntu developers, telling them that, "Netflix will play with Chrome stable in 14.02 if NSS version 3.16.2 or greater is installed."

  

  Source: http://www.engadget.com/2014/09/19/netflix-linux/

  Submitted by: Arnfried Walbrecht

  


  China seeks to shun Western software


  China is developing a homegrown operating system that could be ready as soon as October as part of an effort to wean itself from Western-made software, according to a Sunday report from the Xinhua government news agency, reports Technewsworld.com.

  

  Following hard on the heels of China’s announcement last month that it had launched an investigation of Microsoft under the country’s antimonopoly laws, the latest news suggests the new operating system first will appear on desktop devices and then be extended to smartphones and other mobile devices in three to five years.

  

  The now-defunct Red Flag Linux software could be part of the new OS, according to Computerworld.

  

  Source: http://www.asianage.com/technology/china-seeks-shun-western-software-515

  Submitted by: Arnfried Walbrecht

  


  Ubuntu gets closer to debut in Meizu MX4 phone


  The Ubuntu project announced a stable build for Ubuntu Touch phones, a week after Meizu tipped an Ubuntu version of the Meizu MX4 phone due in December.

  

  The Ubuntu for Phones team at the Canonical’s Ubuntu Project announced the arrival of the first image from the ubuntu-rtm (release to manufacturing) distribution for phones. The announcement followed last week’s tease from Meizu, saying a version of the Android-based Meizu MX4 was on schedule for shipping with Ubuntu in December.

  

  The RTM image of Ubuntu Touch “seems to be the most stable ubuntu-rtm image we ever had,” writes Łukasz ‘sil2100′ Zemczak of the Ubuntu Phones team. “Most blockers have been resolved (along with the no-input unity8 lockup bug), with only more minor issues remaining.”

  

  Source: http://linuxgizmos.com/ubuntu-gets-closer-to-debut-in-meizu-mx4-phone/

  Submitted by: Arnfried Walbrecht

  


  Google and Dropbox Team on Open Source Security


  In an effort to make open source security tools more user friendly, Google and Dropbox announced Thursday that they have teamed up with the Open Technology Fund to form “Simply Secure." The goal of the new non-profit organization is to “help craft usably secure technologies and make them available for everyone.”

  

  This is the second time this week a major technology company has launched an open source initiative. On Monday, Facebook announced its new TODO initiative, which is focused on developing best practices and tools to support open source development between companies. Google and Dropbox are also participating in the TODO collaboration.

  

  The companies said the importance of providing easy-to-use secure tools has become increasingly important following revelations by Edward Snowden that the NSA, GCHQ, Unit 2800 and other spy agencies penetrated numerous technology organizations and collected personal data from millions of people.

  

  Source: http://www.cio-today.com/article/index.php?story_id=103001NS3OFY

  Submitted by: Arnfried Walbrecht

  


  Samsung News And Rumors: Smartphone Running Linux-Based Tizen Operating System Planned To Debut In India, Report Says


  Tizen is a Linux-based operating system that Samsung already uses in some of its cameras and its Galaxy Gear line of wearable tech. The operating system has wide functionality with potential use in smart appliances and smart TVs. As of yet, Tizen has yet to be used in a major smartphone, but Samsung may be trying to introduce this operating system into its smartphone line starting with a run in India, according to the report.

  

  Samsung's current line of Galaxy phones and tablets all run using Google's Android operating system, which also supports smartphones from major competitors like LG and Motorola. If Samsung were able to get a Tizen device off the ground, it could create a mobile software ecosystem to rival Google's Android, Microsoft's Windows and Apple's iOS, making the gadget giant more self-sustaining and less dependant on partner companies.

  

  Source: http://www.gamenguide.com/articles/13347/20140923/samsung-news-and-rumors-smartphone-running-linux-based-tizen-operating-system-planned-to-debut-in-india-report-says.htm

  Submitted by: Arnfried Walbrecht

  


  3 tools that make scanning on the Linux desktop quick and easy


  Whether you're moving to a paperless lifestyle, need to scan a document to back it up or email it, want to scan an old photo, or whatever reason you have for making the physical electronic, a scanner comes in handy. In fact, a scanner is essential.

  

  But the catch is that most scanner makers don't have Linux versions of the software that they bundle with their devices. For the most part, that doesn't matter. Why? Because there are good scanning applications available for the Linux desktop. They work with a variety of scanners, and do a good job. Let's take a look at a three simple but flexible Linux scanning tools. Keep in mind that the software discussed below is hardly an exhaustive list of the scanner software that's available for the Linux desktop. It's what I've used extensively and found useful.

  

  Source: http://opensource.com/life/14/8/3-tools-scanners-linux-desktop

  Submitted by: Arnfried Walbrecht


  Command & Conquer

  PDF-Page-Grep


  Lucas Westermann


  R


  ight at the start of September, I received an email from a long-time reader, who I've had previous contact with. The gist of the email was that he had written a script to search a PDF document, and then take each page with a match, and create a new PDF of only the results. The original scenario was that of a law student who had to hunt through PDFs that were thousands of pages long, but I can foresee it being useful for others too (students making a study guide on a particular topic, picking interesting articles out of PDFs, etc). As such, this month I will be giving a quick run-through of how the program works, and the technologies/commands it is based on.

  

  The Requirements


  
    	grep – in package grep (should be pre-installed in Ubuntu)


    	pdfinfo – in poppler-utils (should be pre-installed in Ubuntu)


    	pdfunite – in poppler-utils (should be pre-installed in Ubuntu)


    	pdftotext – in poppler-utils (should be pre-installed in Ubuntu)


    	pdfjam – in pdfjam package in Ubuntu, or textlive-extra-utils.

  


  Most of these commands are fairly self-explanatory. The most cryptic ones are grep (which is a search command for the command-line), and pdfjam (which is a shell script for merging and splitting PDFs).

  

  The Script

  The most recent copy of the script can be found here: http://homepages.dcc.ufmg.br/~lcerf/en/utilities.html#pdf-page-grep (the “download it” link is under ‘Installation’). I will be referencing line numbers, so it may be useful to download a copy and open it in a text editor that offers line numbers, in order to follow along.

  

  If you don't want to include a full path every time you search a PDF, you can either symbolically link it to /usr/bin (with: sudo ln -s /path/to/script /usr/bin/pdf-page-grep). Or create a scripts folder in your user's home, and then add it to your PATH variable.

  

  How to use it


  
    	Install the requirements


    	Make the script executable: chmod +x /path/to/file Make sure to change the path to the location you saved the script to.


    	Run the script

      
        	Without arguments to see the usage information


        	Run the command based off the usage information – such as: /path/to/pdf-page-grep -i issue*.pdf pattern: command & conquer OR pattern (empty to stop):

      

    

  


  This example would search for Command & Conquer (while ignoring upper and lower case) in all PDFs whose name starts with ‘issue’, and ends with ‘.pdf’ (which should cover all copies of FCM, unless you rename them). This way, you'll end up with a PDF of all C &C articles in the issues you've downloaded.

  

  Naturally, there are other options you can use (-E for extended regular expressions, -F for fixed strings, -P for perl regular expressions, -w for matching only whole words, and -x for matching whole lines).

  

  How does it work?

  If you open the script up in your favourite text editor, you'll notice that it's formatted nicely with indentations, comments, spacing, and a uniform system to loops. The first section of the file (lines 1-7) would fall under what I class as “preamble” - it contains information on the author, sets the environment at the top for Linux, gives information on the license, and then sets up the variables used later in the file. In this case, the only variable used is SUFFIX – which, as you might imagine, is the suffix added to the new PDF file that contains the matches (default value: -matches).

  

  Lines 9-25 contain an if-statement which checks whether or not there are any arguments – if not, it will then print out the usage information. When I write scripts such as these, I tend to also include a check to see if the argument is “-h”, and/or compare it to a list of accepted arguments. In this case I would skip the accepted arguments, as you're looking for file names, and can hardly have a complete list to compare against.

  

  Lines 27-28 create a temporary location for storing the PDFs while they're being processed by the script (as it converts the PDF with pdftotext in order to use grep on them). This is an accepted practice for keeping the script results clean (i.e. not leaving files all over your home folder).

  

  Lines 29-30 uses the trap command to empty the temporary folder when the script exits (including when the script is interrupted by the user or system – i.e. when you hit ctrl+c).

  

  Lines 31-44 are a while loop that repeatedly asks the user for possible search terms, until they enter an empty string. Once an empty string is entered, it moves on in the program. This pattern can also be a basic regular expression.

  

  Lines 46 – 54 is a for loop that checks the passed arguments for any beginning with a hyphen – as it is assumed it indicates an argument. If I were the one authoring this script, I would have opted for an array of acceptable options, and searched for them instead. If your filename starts with a hyphen, I would imagine the script would fail. However, it is pretty uncommon for a file to be named in such a way.

  

  Lines 56 – 93 is a for loop that basically reverses the check from lines 46-54 (checks for any argument not beginning with a hyphen), and assumes it is a filename. It then starts a new line, prints “matching pages in <filename>:<list of pages>”. In the end you should have a list of every PDF searched, as well as a list of every page number that matched one of your search terms. The last two lines will tell you where the results were saved, and how many matching PDFs were found. The actual search is done by converting each page of the pdf to text (using pdftotext), and then piping it through grep to find the results. If there is a match, it will return the page number, remember it in the variable $sel, and continue to the next page. After the for loop of pages is complete, it will increment the number of matched PDFs (if there was a match), extract the matched pages into a temporary file, reset the list of matched pages, and then remember the original name of the last matched PDF.

  

  Lines 96-101 check if the number of matched PDF files exists. If not, there were no matches, and the program exits.

  

  Lines 102-112 cover the case of one matching file (outputs “1 matching PDF file”, and then moves the temporary file into the final PDF of results – which avoids issues with pdfunite expecting more than one file), as well as multiple matches. When multiple matched PDFs exist, it will use pdfunite to merge the files into the -matches pdf.

  

  Line 113 – This line simply prints out the name of the resulting file, so the user can find it.

  

  I've skimmed over certain specifics of the script for two reasons – one being brevity, and the other being that figuring out exactly how a script works simply by reading it and running it is a good skill to have, especially if you plan on writing your own scripts or programs. If anyone has particular questions about a certain segment of the script, you're welcome to send me a quick email. If you have any other questions, suggestions, or requests, you're welcome to send me an email at lswest34+fcm@gmail.com.


  Drawing with Inkscape – Part 29


  By Mark Crutch


  L


  ast time I introduced Inkscape's notion of clones – duplicate objects that maintain a link to their parent. I also demonstrated that clones can be independently transformed whilst still maintaining that link, so you can set the basic shape, fill and stroke on a parent object, but then additionally skew, scale and rotate the clone. Keep that capability in your mind, as we'll be returning to it later in this article, but first I need to talk to you about cloning groups.

  

  It's possible to clone almost any type of object in Inkscape. Previously I used rectangles, text and images, but the same rules apply to stars, spirals and paths. The exception is 3D boxes, which don't behave at all well when cloned, and tend to disappear when the parent is modified. You can 'ungroup' a 3D box to convert it into normal paths; if you then group those together again, you can clone that group, but you'll have lost the ability to edit the parent using the 3D Box tool.

  

  Whether created from a 3D box, or via any other mechanism, groups are a prime target for cloning. Having drawn a complex object made up of several different parts, it's useful to be able to clone it in its entirety, rather than having to clone each part separately. Let's use this technique to create a clone army using the snowman we last saw in part 14.


  [image: ]


  The parent object here is the snowman at the front, which has been cloned multiple times, and the clones scaled. The parent is a group which contains other groups – one for the hat, one for each arm, and so on. It's only when you drill down a couple of levels deep that you finally get to real paths and shapes, but cloning a group automatically includes all of that structure, no matter how deep it goes.

  

  Creating lots of clones like this can be time consuming, but there are a couple of tricks to speed up the process. The first is to use Inkscape's Tiled Clones feature (Edit > Clone > Create Tiled Clones...) which is a hugely powerful, but extremely complicated, tool. I'll be covering some aspects of it later in this series. The other approach – and the one I took here – is to create the first clone, then drag it around the screen, 'stamping' it in place by pressing the spacebar. Each copy that you stamp is a duplicate of the object you're dragging, and, as we found out last time, a duplicate of a clone retains a link to the original parent object. By working from the back to the front, pausing occasionally to re-scale the clone that's being dragged, it took only a few moments to create all the clones in the image.

  

  One big problem with clones is that they can appear too similar. Our clone army loses some menace through all being exactly identical, right down to their arm positions. One way to deal with this is to break your group apart into smaller sections, and clone them separately. For example, if we break the snowman apart to separate his hat, arms, pipe, scarf and nose from the main group, we can create an army with a little more individuality by simply omitting or transforming them on some of the characters.
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  This technique is one that I use frequently when creating comic strips. A character's body is often cloned directly from one panel to the next, but the arms or legs are cloned separately so they can 'move' between scenes to add a little dynamism to the strip. Often I'll also scale and crop the clones, to give the impression of a camera zooming into or out of the scene. Don't forget that you can still draw extra elements on top of your clones to truly make each one individual. That's how I deal with a cloned character that may be speaking in one panel and silent in another: the original parent has no mouth, then it's drawn on the clones separately for each scene.

  

  When cloning a group, it's important to realise that the clone is not a group itself. You can't enter the clone to make changes. You can, of course, still enter the parent and make changes there. They will propagate to the clones as usual. When dealing with groups, though, you not only have the option of changing fills, strokes, filters and transformations, but also the possibility to delete objects in the group, or create new ones. Even those changes will propagate to the clones, offering up one rather nice way to use clones which isn't immediately obvious.

  

  For this technique, we'll need a group. Ideally it would be empty, but Inkscape won't let you create an empty group, so we'll have to put something in it. A good starting point is to draw a large square, almost filling the canvas, with a stroke but no fill. Then immediately group it using the icon on the main toolbar, the Object > Group menu, or by pressing CTRL-G. Select the square and check the status bar: it should confirm that you've got a group of one object.

  

  With the group selected, press ALT-D to clone it. With the clone now selected, press the 'H' key, select the Object > Flip Horizontal menu, or use the toolbar button to mirror the clone horizontally. You shouldn't see any obvious change as you've mirrored it directly on top of the parent. Next, send the clone to the back of the Z-order using the toolbar button, Object > Lower to Bottom, or by pressing the END key. Finally, double-click on the parent (remember, it's now at the top of the Z-order, so you can just double-click on its stroke) to enter the original group. Now switch to the Pencil or Calligraphy tool and draw something.

  

  If you've set everything up correctly, you should find that each time you release the mouse button, the line you've drawn is immediately reproduced as a mirror image at the opposite side of the canvas. All that's actually happening, of course, is that the objects you're adding to your group are being reflected (in every sense) in the clone of the group. Because the square you drew has no fill, the clone shows through as a mirroring of your every stroke.

  

  You're not limited to the Pencil and Calligraphy tools, of course. Anything you draw, regardless of the tool (except the problematic 3D boxes, of course) will be mirrored, making it a useful way of making symmetric designs. It's surprising how readily a few random paths will become a person, alien, insect or plant once you introduce a little symmetry, making it a great way to get started when inspiration has left you.
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  As soon as you have drawn another object in the group, there's no need for the square any more, so delete it if you wish. I prefer to leave it in place for reference until I've finished drawing, then remove it as a final step. Either way, don't feel constrained by it – the square is only there to provide some initial content for the group, so don't be shy about drawing beyond its limits.

  

  Once you've got the hang of the basic technique, it shouldn't be hard to see that extending it to three clones lets you create drawings that are mirrored both horizontally and vertically.
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  Flipping the clones like this is a good start, but why not try other transformations on them? Rotating them is a great option and holding down CTRL to lock the rotation to the fixed steps defined in Inkscape's preferences can quickly produce kaleidoscopic effects. Try setting different opacities for each group, or blurring some of them. Within a few minutes, you'll be creating works of abstract computer art with just a couple of squiggles of the mouse.

  

  This example was made by rotating the original square about its bottom right corner. By moving the center of rotation for the original, it was already in the correct place as each clone was created. Then I simply cloned the original group and rotated it whilst holding CTRL. I reduced the opacity and increased the blur a little. Pressing CTRL-D created the next clone, and the cycle was repeated until I had completed a full circle of clones. Bringing the original to the front, double clicking on it, then drawing a single shape with the Pencil tool (with the Shape control set to “Ellipse”) produced this abstract image, spiralling away to nothingness.
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  If you do try this technique and decide to use blurring on your clones as I have done here, you'll soon find that Inkscape can slow down to a crawl. It's not just blurring that has this effect – any of Inkscape's filter functions can result in the rendering engine having to perform copious calculations, slowing it down considerably. If you find this to be a problem, you can try turning off the display of filters using the View > Display Mode > No Filters option. Any changes you make to filtered elements will still be stored, saved and applied if you export a bitmap – they just won't show up on screen. Use View > Display Mode > Normal to see the page in its fully rendered glory. You can press CTRL+5 (on the numeric keypad) to cycle through the view modes, including the “outline” mode which is great for finding rogue elements that have become invisible due to too much blurring or too low an opacity. This is a useful shortcut to learn if you find yourself plagued by slow redraws as you can press it at any time – even in the middle of a redraw – if you don't need to see the fully filtered version of the image for the particular edit you're making at the time.

  

  Whether you're creating swirly patterns or armies of characters, there will come a time when you want to break the link between a clone and its parent. Perhaps your snowman needs a completely different smile to its comrades, or your soft, pastel spiral needs a single bright red segment to draw the eye. What you really want is a copy of the parent object that you can modify as much as you want without being constrained by that pesky linkage. You could, of course, just create a copy as normal, but if you've already got a clone in the right place, it seems a shame not to use it. The Edit > Clone > Unlink Clone menu item will do what you want, turning any selected clone into a plain, old fashioned copy. Use it wisely because although it's easy to convert a clone into a copy, you can't go back in the opposite direction.


  
    Mark uses Inkscape to create three webcomics, 'The Greys', 'Monsters, Inked' and 'Elvie', which can all be found at http://www.peppertop.com/
  


  Arduino


  by Ronnie Tucker


  L


  ast month was a merge of two sketches into one which resulted in keypad presses being displayed on an LCD screen. This month I’m keeping the same circuit but adding more code.

  

  Welcome!

  

  I thought it’d be nice if the Arduino could take the keypad input and check it against a known password. Well, there just happens to be a handy dandy library called Password. You can grab it from: http://playground.arduino.cc/Code/Password.

  

  As it says on the page, download, unarchive and copy the folder to your sketches library folder. Now you can use the #include <Password.h> line in your code.

  

  Merging the code wasn’t going so well for me until I found this example: https://sites.google.com/site/arduinomega2560projects/home/level-3/keymembrane-and-lcd-password-lock. This is pretty much what I wanted to achieve – but with my 3x4 keypad.

  

  After much tinkering, I managed to get it working. One thing that did catch me out for a while was the include statements. Apparently you shouldn’t put things between the include statements. I had the Password(“4321”) line right below the Password include, but before the LiquidCrystal include, so that stumped me for a bit. Once I got past that, I got stumped with why it wouldn’t accept the password. After much trial and error I found that in the line:


  
    case ' ': guessPassword(); break;
  


  the “case ‘ ‘“ statement is effectively the ‘enter’ key for the password. So, changing the ‘ ‘ to ‘#’ worked a treat. After that I tidied up the before and after screens.

  

  Now it says ‘Enter code:’. You enter a four digit code and press the hash key (#) to finish. The LCD screen will either say ‘INVALID PASSWORD’, pause, and return to the ‘Enter code:’ screen, or it will say ‘VALID PASSWORD’, pause, display ‘Welcome!’, pause, then return to the ‘Enter code:’ screen.

  

  My code is at: http://pastebin.com/V0f9GBFf.

  

  Now, wouldn’t it be nice if it stopped at ‘Welcome!’ and waited for something to happen before needing a code or something…?


  LibreOffice Part 41

  Copy Sheet Macro


  by Elmer Perry


  B


  ack in parts 8-12 (FCM issues 53, 55-58), I took you from a blank spreadsheet to a full working budget spreadsheet. Something similar is what I use twice a month to do my home budget. I keep a whole year of budget spreadsheets in one document, which means twice a month I copy the sheet, rename it, and make sure I get all the settings correct to put a copy of the current sheet at the end of the sheet tabs. Believe me, mistakes have been made. Curses have been breathed. Innocent computers have been threatened.

  

  In time, I decided, since I was such a fallible, flawed human being, I needed to reduce the number of steps necessary to complete this task in order to lessen my chances for mistakes. The result was a macro where all I have to do is give the sheet a new name. The macro handles all the rest, making sure it is copied and placed at the end of the tab list. The task fits perfectly into the idea behind macros, a repeatable process that automation can speed up, or prevent mistakes. Today, I share it with you.

  

  The Manual Method
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  In order to appreciate a macro, you really have to understand what it's doing for you, and the mistakes you can make. Therefore, I will start with the description of the manual process that the macro makes simpler. There is actually more than one way to copy a sheet in Calc, but I will show you the dialog method with all the options.

  

  Right-click on the tab of the sheet you want to copy and select Move/Copy Sheet. The Move/Copy dialog appears. You then select Copy. One of the mistakes I have made is to forget this. I end up just renaming my sheet. Under “Insert Before” select the option at the end “-move to end position-”. If I forget this one, the sheet is placed before the current sheet rather than at the end where I want it. Finally, I have to rename the sheet. There have been times while trying to remember to get the other settings right, that I have forgotten to actually change the name. When I do, the copied sheet gets the name of the current sheet with a “_2” appended to the end. Click OK to execute the settings.

  

  I know, you're thinking that it's not that bad, but after a few times getting it wrong, your inner Hulk comes out and you want to smash things. Okay, maybe that's just me. Trying to balance the home budget is frustrating enough without the bonus of mistakes while copying the spreadsheet.

  

  The CopySheet Macro


  
    Sub CopySheet

     dim Sheet1 as String

     dim Sheet2 as String

     dim Doc as Object

    

     Doc = ThisComponent

    

     If NOT Doc.supportsService("com.sun.star.sheet.SpreadsheetDocument") then

     MsgBox "This Macro Only Works with Calc Spreadsheets"

     Exit Sub

     End If

    

     Sheet1 = Doc.CurrentController.ActiveSheet.Name

     Sheet2 = InputBox("Enter Name for Copied Sheet:", "Copy Sheet", Sheet1)

     If Sheet2 = "" Then Exit Sub

    

     Do While Doc.Sheets.hasByName(Sheet2)

     Sheet2 = InputBox(Sheet2 + _

     " already exists, select a different name:", "Copy Sheet", Sheet2 + "2")

     If Sheet2 = "" Then Exit Sub

     Loop

    

     Doc.Sheets.CopyByName(Sheet1, Sheet2, Doc.Sheets.Count)

    End Sub
  


  The macro is not very long and you can easily type it in. You can also copy it from http://pastebin.com/s3iTGjN6.

  

  The micro starts by declaring 3 variables used in the body of the macro. “Sheet1” and “Sheet2” are strings that will contain the names of the current sheet (Sheet1) and the new sheet (Sheet2). The “Doc” variable will hold a reference to the current document. It is declared as a type Object because the reference is to a LibreOffice API object.


  
    Doc = ThisComponent
  


  ThisComponent is the current active document in LibreOffice. In this case, the macro is looking for a Calc spreadsheet.


  
    If NOT Doc.supportsService("com.sun.star.sheet.SpreadsheetDocument") then

     MsgBox "This Macro Only Works with Calc Spreadsheets"

     Exit Sub

    End If
  


  The “If” statements check to make sure that the current document is a Calc spreadsheet. It checks to see whether the document supports the SpreadsheetDocument service, identifying it as a Calc spreadsheet and not some other document type. If it is not a spreadsheet, the macro pops up a message box telling the user the macro works only with spreadsheets. The macro then executes an “Exit Sub” that exits the macro without running any more of the code.


  
    Sheet1 = Doc.CurrentController.ActiveSheet.Name
  


  The macro uses the Doc object to extract the name of the current sheet. The breadcrumb dot notation goes through a progression of getting more specific. CurrentController is a reference to the service that controls the document. ActiveSheet is a reference to the currently active sheet in the document. Finally, Name gets the name of the current sheet and this is assigned to the variable Sheet1.


  
    Sheet2 = InputBox("Enter Name for Copied Sheet:", "Copy Sheet", Sheet1)
  


  To get the name of the new sheet, the macro uses an InputBox function. The InputBox takes 3 arguments:


  
    	The prompt to show the user (“Enter Name for Copied Sheet:”).


    	The title of the InputBox window (“Copy Sheet”).


    	The default text (it just uses the name of the current sheet [Sheet1] as the default text).

  


  If the user clicks the OK button, the InputBox will return the string entered in the text box or the default text when no changes are made. If the user clicks the Cancel button, a blank string is returned.


  
    If Sheet2 = "" Then Exit Sub

    

    Do While Doc.Sheets.hasByName(Sheet2)

     Sheet2 = InputBox(Sheet2 + _

     " already exists, select a different name:", "Copy Sheet", Sheet2 + "2")

     If Sheet2 = "" Then Exit Sub

    Loop
  


  Now, the macro must use some logic to determine how to proceed. The “If” checks to see if the returned string is blank. If so, that means that the Cancel button was pressed, therefore the “Exit Sub” is executed. “Exit Sub” exits the macro without running any more of the remaining code.

  

  The Do While...Loop checks to see if another sheet in the Calc document has the same name. The hasByName method checks the supplied name against the names of all the sheets in the collection. If a match is detected, the macro uses an InputBox to prompt the user for a new, unmatched name. The Do While...Loop will loop until the name in Sheet2 does not match the name of any other sheet. The “If” inside the loop exits the macro if Cancel is pressed. If the name is unmatched from the start, the loop never runs. This prevents two sheets from having the same name.

  

  NOTE: The underscore (_) in the InputBox statement is used to break a long line up into shorter lines. LibreOffice Basic requires that the underscore is the last thing on the line. Nothing, not even a space, can follow it. When lines are joined in this way, LibreOffice Basic sees them as one line.


  
    Doc.Sheets.CopyByName(Sheet1, Sheet2, Doc.Sheets.Count)
  


  The last line of the macro brings all this preparatory work together to finally execute the copy. Sheets is a reference to the collection of sheets in the document. CopyByName is the method that actually copies the sheet and moves it to the end of the sheet tabs. The CopyByName method has 3 parameters:


  
    	The sheet to copy from (Sheet1).


    	The sheet to copy to (Sheet2).


    	The position of the new sheet (Doc.Sheets.Count).

  


  Count is the total number of sheets in the collection (Sheets). Since the sheet numbers are referenced starting with 0, the use of Count here puts the new sheet at the end.

  

  Creating the Calc Macro Module

  When I developed and wrote the CopySheet macro, I created a macro module for Calc. Here I could store this macro as well as any future macros designed for the Calc program. It's a good idea to group like macros together.
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  To create the module, Tools > Macros > Organize Macros > LibreOffice Basic. The LibreOffice Basic Macros dialog opens. Click Organizer to get the LibreOffice Basic Macro Organizer dialog. Under My Macros > Standard, there is a default module named Module 1. Select it and click Delete. With Standard selected, click New. Name the new Module “Calc” and click OK. Click Close.
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  Now back in the LibreOffice Basic Macros dialog, select the new “Calc” module you just created and click Edit, opening the LibreOffice Macro Editor. Delete the automatically created “Sub Main” and “End Sub”. Type in or copy and paste the SheetCopy macro into the editor. Save the module and close the editor.

  

  Test The Macro
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  After typing in the macro and saving it, you will want to test it to make sure you typed everything correctly. First, open a Calc document or create a new one. You can then test the macro by going to Tools > Macros > Run. Under Library, select My Macros > Standard > Calc. Under “Macro Name” select CopySheet and click Run. Enter a name for the sheet like “New Sheet.” Click OK. If all goes well, a new sheet is created with the name you gave it. You will want to repeat the test and not change the name to see if the macro prompts you to change the name. Also, test to make sure the macro stops when you click on Cancel rather than OK. For the final test, open a text document and run the macro. You should get the message telling you that the macro works only on spreadsheets.


  
    NOTE: Back in Full Circle issue 64 (LibreOffice Part 17: Macros), I showed you how to create a menu shortcut to a macro. This is a good candidate for such a shortcut. Create the menu and shortcut in Calc.
  


  Macros like CopySheet can speed up your processes and prevent you from making mistakes, which is the whole idea behind macros. This is just an example of something you can do with macros, but you can write your own macros that can expand the use or capabilities of any of the LibreOffice programs, or just reduce a task you do often. A Google search for “LibreOffice Basic” is a good place to start learning more.


  Graphics - GIMP

  Perspective Clone


  Written by Ronnie Tucker


  N


  icholas is absent this week, so I thought I’d step in and show you a much overlooked, yet powerful, feature in GIMP: Perspective Clone.

  

  Cloning will take what’s under your source and copy it to a destination. That’s ‘create’ for making two of you in one photo, but what if the cloning involves perspective. That is: smaller in the distance and larger in the foreground.

  

  I’ll use this photo as a reference:
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  First, click the Perspective Clone tool:
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  In the Tool Options tab (usually on the left), make sure Modify Perspective is chosen:
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  Now click on the image and adjust the corner boxes to align with the perspective of the image:
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  Now that GIMP knows the perspective of the building choose Perspective Clone from the Tool Options:


  [image: ]


  Now, like you would with normal cloning, hold down CTRL to choose your source and click.

  

  Finally, draw where you want to clone to. Simple as that!
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  How-To

  Installing Oracle 11g R2 Express (XE) on 64-bit Ubuntu


  Written by Frank Oberle


  O


  racle, which provides the world’s leading Relational Database Management System (RDBMS), offers a free developer license for their product, but *buntu users seem to be left in the cold. All is not lost, however, because in this article I’ll show you how to install and run the Oracle 11gR2 Express Edition on 64-bit versions of Ubuntu 12.04 and 14.04 – this may work for other Debian-based systems, but I haven’t confirmed that. If you are serious about becoming a database guru, this is an easy way to obtain a professional environment in which to do so.

  

  The following will explain how to obtain the rpm (Red Hat Package Manager) package, convert it to a deb package, perform the initial set up of Oracle XE, and how to begin using Oracle’s SQL-Plus command-line interface.

  

  There are a few limitations. Oracle is suitable only for 64-bit *buntu installations. The database will be limited to a mere 11 GB of user data, and is limited to using only one processor and no more than 1 GB of memory. The installation requires at least 512 MB. Details about Oracle XE can be seen at: http://www.oracle.com/technetwork/database/database-technologies/express-edition/overview/index.html

  

  To download the package, you will need to create a free online account with Oracle – a very small price to pay, and, based on my experience, one that doesn’t result in any unsolicited material in your in-box. The e-mail and the password you select also give you access to other developer utilities. Throughout these instructions, the use of a text editor is required. The example commands assume the use of gedit, since that is Ubuntu’s default editor, but you can use any text editor you want.

  

  Step A: You will need to know the amount of installed RAM as a number of bytes. The easiest way to do this is to see the value displayed in “System Settings ...” from the desktop, but you may also use:


  
    sudo lshw -short -C memory
  


  The number must be at least 512 MB; to convert that to an exact byte count, use the formula:


  
    512 * 1,048,576 = 536,870,912 bytes (multiply GB by 1073741824 to obtain bytes)
  


  Write this number down for reference for the later steps. If you wish to allocate more RAM to Oracle, you may do so, but the minimum is usually sufficient for a single user running multiple applications.

  

  The remaining commands are all issued from a terminal, opened with Ctrl+T in Ubuntu.

  

  Step B: Oracle 11gR2 XE requires at least 2GB of available swap space. Determine if your available swap space (in gigabytes) is sufficient by issuing the following command:


  
    free -g
  


  Look for a line similar to the following:


  
    Swap: 13 0 13
  


  In this example, the machine has 13 GB available (the third number). If you have insufficient swap space, you will need to either create a swap partition or a swap file. Instructions for doing this in Ubuntu are readily available on the web, and so will not be repeated here.

  

  Pre-Installation Steps

  

  Step C: Download the zip file containing the 64-bit Linux package named oracle-xe-11.2.0-1.0.x86_64.rpm by selecting downloads from the previous page, or by directly choosing: http://www.oracle.com/technetwork/database/database-technologies/express-edition/downloads/index.html

  

  Step D: Unzip the file using the following command:


  
    unzip oracle-xe-11.2.0-1.0.x86_64.rpm.zip
  


  Step E: If you do not have the packages alien, liaio1, and unixodbc, you will need to install them. Since no harm will be done if they are already installed, enter the following command:


  
    sudo apt-get install alien libaio1 unixodbc
  


  Step F: Convert the red-hat rpm package to an Ubuntu .deb package using the following command:


  
    sudo alien --scripts -d oracle-xe-11.2.0-1.0.x86_64.rpm
  


  Alien takes quite a while to do all the required conversions and reconfiguring of the rpm package, but you can use this time to perform all of the steps up to “Step M Perform the Installation,” but don’t proceed beyond that until the oracle-xe-11.2.0-1.0.x86_64.deb package has been created.

  

  Step G: Create a chkconfig script using a text editor: The Red Hat installer assumes the existence of a file /sbin/chkconfig that doesn’t exist in Ubuntu. Do not load the chkconfig package that is available for Ubuntu, though, since it can cause errors. Instead, create the file directly using the following commands:


  
    sudo gedit /sbin/chkconfig
  


  When the blank file is opened, copy and paste the following into the editor:


  
    #!/bin/bash

    # This file was created for, and only required for the

    # Oracle RDBMS 11gR2 XE installation.

    file=/etc/init.d/oracle-xe

    if [[ ! `tail -n1 $file | grep INIT` ]]; then

     echo >> $file

     echo '### BEGIN INIT INFO' >> $file

     echo '# Provides: OracleXE' >> $file

     echo '# Required-Start: $remote_fs $syslog' >> $file

     echo '# Required-Stop: $remote_fs $syslog' >> $file

     echo '# Default-Start: 2 3 4 5' >> $file

     echo '# Default-Stop: 0 1 6' >> $file

     echo '# Short-Description: Oracle 11g XE' >> $file

     echo '### END INIT INFO' >> $file

    fi

    update-rc.d oracle-xe defaults 80 01
  


  Save the file and close the editor.

  

  Step H: Now apply execute privileges to the /sbin/chkconfig file you just created using the following command:


  
    sudo chmod 755 /sbin/chkconfig
  


  You can confirm the settings have been applied properly using the following command:


  
    ls -l /sbin
  


  You should see:


  
    -rwxr-xr-x 1 root root 660 Nov 23 20:29 /sbin/chkconfig
  


  Step I: Define the Linux Kernel parameters

  

  Oracle 11gR2 XE requires the setting of some additional kernel parameters. First we’ll create a suitable Oracle configuration file using the editor, and then we’ll make the settings permanent by applying them to the kernel so they’ll be set on each reboot. First create the file using the editor.


  
    sudo gedit /etc/sysctl.d/60-oracle.conf
  


  When the blank file is opened, copy and paste the following into the editor:


  
    # Oracle 11g XE kernel parameters

    # Temporary file used for Oracle Installation

    fs.file-max=6815744

    net.ipv4.ip_local_port_range=9000 65000

    kernel.sem=250 32000 100 128

    kernel.shmmax=536870912
  


  The value used for kernel.shmmax in the last line above (536870912) is the minimum recommended amount of RAM from Step A above. For use of Oracle while learning, this is probably sufficient, but the value may be increased up to the amount of RAM in your system if desired (i.e. the number does not need to match the amount of RAM in your system, but it cannot exceed it.)

  

  Save the file and close the editor.

  

  Confirm the settings have been applied using the following command:


  
    sudo cat /etc/sysctl.d/60-oracle.conf
  


  Step J: Load the Linux Kernel parameters


  
    sudo service procps start
  


  This command should return:


  
    me@myMachine:~$ procps stop/waiting
  


  Verify the that parameters have been loaded by issuing the command:


  
    sudo sysctl -q fs.file-max
  


  This command should return something like the following:


  
    me@myMachine:~$ fs.file-max = 773266
  


  Step K: On an Ubuntu system, /dev/shm is defined as a link to /run/shm, but a link won’t satisfy Oracle, so the link needs to be removed and replaced with an actual directory which is then mounted. To do so, execute the following commands:


  
    sudo rm -rf /dev/shm

    sudo mkdir /dev/shm

    sudo mount -t tmpfs shmfs -o size=2048m /dev/shm
  


  (The size value can be any value up to the size of your RAM in MB, but I’ve found 2048 is quite sufficient).

  

  To make these changes permanent, we need to create another file called S01shm_load in the directory /etc/rc2.d, so another editing session is required:


  
    sudo gedit /etc/rc2.d/S01shm_load
  


  Copy and paste the following lines into the editor:


  
    #!/bin/sh

    # This file was created for and only required by

    # the Oracle RDBMS installation.

    case "$1" in

     start) mkdir /var/lock/subsys 2>/dev/null

     touch /var/lock/subsys/listener

     rm /dev/shm 2>/dev/null

     mkdir /dev/shm 2>/dev/null

     mount -t tmpfs shmfs -o size=2048m /dev/shm

     ;;

    *) echo error

     exit 1

      ;;

    esac
  


  Save the file and close the editor.

  

  Confirm the settings have been applied using the following command:


  
    ls -l /etc/rc2.d
  


  There should be an appropriate line for the new file similar to the following:


  
    -rw-r--r-- 1 root root 273 Nov 23 20:41 S01shm_load
  


  Now set execute permissions for the file with the command:


  
    sudo chmod 755 /etc/rc2.d/S01shm_load
  


  Confirm that this was successful by repeating the last command:


  
    ls -l /etc/rc2.d
  


  If successful, the appropriate result line should look like this:


  
    -rwxr-xr-x 1 root root 273 Nov 23 20:41 S01shm_load
  


  Using the mount command, confirm that the shmfs temporary file system has been loaded by looking for a line like the following toward the end of the listing:


  
    shmfs on /dev/shm type tmpfs (rw,size=2048m)
  


  Step L: The Red Hat installation process uses the /bin/awk utility but, since Ubuntu places this at /usr/bin/awk, we need to create a symbolic link to the location Red Hat expects by issuing the following command:


  
    sudo ln -s /usr/bin/awk /bin/awk
  


  Create an empty listener directory and listener file for Oracle’s use by issuing the following commands:


  
    mkdir /var/lock/subsys touch /var/lock/subsys/listener
  


  DO NOT PROCEED BEYOND THIS POINT UNTIL THE oracle-xe-11.2.0-1.0.x86_64.deb package has been created (see step F).

  

  Step M: Perform the Installation

  

  Ensure that you are in the directory where the oracle-xe-11.2.0-1.0.x86_64.deb file was created in Step F. Begin the installation with the following command:


  
    sudo dpkg --install oracle-xe_11.2.0-2_amd64.deb
  


  Step N: Remove extraneous installation artifact

  

  By default, the Red Hat installation procedure creates a desktop start icon, but this won’t work under Ubuntu, so either reconfigure it, or delete it with the following command:


  
    rm $HOME/Desktop/oraclexe-gettingstarted.desktop
  


  Step O: Configure the Oracle Installation

  

  Once installed, Oracle needs to be configured prior to using it. The utility to do this is run with the following command:


  
    sudo /etc/init.d/oracle-xe configure
  


  You will need to enter the following information:


  
    	A valid HTTP port for the Oracle Application Express (unless you have a good reason for not doing so, accept the default value of 8080 by pressing Enter at the prompt)


    	A valid port for the Oracle database listener (unless you have a good reason for not doing so, accept the default value of 1521 by pressing Enter)


    	A single password for both the SYS and SYSTEM administrative user accounts; you will be asked to re-enter the password for confirmation. SAVE THIS PASSWORD!! It is for the system user “Oracle.”

  


  You will then be asked whether you want the database service to start automatically each time the computer starts. It is most convenient to have the service run at log-in, so answer “Yes.” You’ll see:


  
    Starting Oracle Net Listener.
  


  Step P: Several environment variables need to be set up for Oracle to run; this is done by editing the existing (hidden) .bashrc file using the following command:


  
    sudo gedit $HOME/.bashrc
  


  Add the following lines to the end of the .bashrc file:


  
    ########################################################

    # The following lines were added on mm/dd/yyyy to support the use of

    # Oracle 11gR02 terminal operations [SQL*Plus] by [Your Name]

    export ORACLE_HOME=/u01/app/oracle/product/11.2.0/xe

    export ORACLE_SID=XE

    export NLS_LANG=`$ORACLE_HOME/bin/nls_lang.sh`

    export ORACLE_BASE=/u01/app/oracle

    export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

    export PATH=$ORACLE_HOME/bin:$PATH

    ########################################################
  


  Save the file and close the editor. Reload your profile by issuing the following commands:


  
    cd $HOME

    . ./.profile
  


  The command above is “period, space, period, slash, period” followed by the word “profile.” The command will only take a second to execute and won’t display anything if it executed successfully.

  

  Step Q: Start Oracle:

  Depending on whether or not you chose the option to have Oracle start at boot, the oracle-xe service may or may not have already been started. Execute the following command anyway:


  
    sudo service oracle-xe start
  


  If the service has already been started, you will receive the message: Oracle Database 11g Express Edition instance is already started Otherwise, the following message will appear:


  
    Starting Oracle Database 11g Express Edition instance.
  


  Step R: Create a Database User For normal activities, you should create one or more individual database user accounts. To do so, execute the following command:


  
    sqlplus sys as sysdba
  


  The following message will be displayed, confirming that your installation has been successful:


  
    SQL*Plus: Release 11.2.0.2.0 Production on Wed May 9 12:12:16 2012

    Copyright (c) 1982, 2011, Oracle. All rights reserved.

    Enter password:
  


  Enter the password you chose in Step O:. Assuming you entered the correct password, the following message will be displayed, confirming that your installation has been successful:


  
    Connected to: Oracle Database 11g Express Edition Release 11.2.0.2.0 - 64bit Production SQL>
  


  It is a good practice to set up one or more separate user accounts for development and experimentation – perhaps even one for each project you are working on. This will permit you to use Oracle without logging out of your current user session. As an example, you would create a user named JohnQ and set his password to “Jello” by entering the following command:


  
    create user JohnQ identified by Jello;
  


  The system will respond with:


  
    User created.
  


  In order to give JohnQ the ability to connect to and use the system to create or access a database, enter the following command:


  
    grant connect, resource to JohnQ;
  


  You may or may not wish to add other permissions to that list, such as dba, depending on your needs. The system will respond with:


  
    Grant succeeded.
  


  Repeat this process to create any other users that may be needed at this time. Step S: Log in as a User and Confirm Operations

  

  The following command will disconnect you from the SYS account, and connect you to JohnQ’s account to confirm that your user setup was successful:


  
    sqlplus JohnQ/Jello
  


  If you simply type “sqlplus” alone, SQL*Plus will prompt for a user id and password. A minimal method of confirming that the database is operational is to execute the following command:


  
    select sysdate from dual;
  


  The system will return something that looks like the following:


  
    SYSDATE

    ------------------

    5-JUN-14
  


  Uninstalling Oracle

  

  To completely uninstall the Oracle RDBMS, execute the following commands from a terminal:


  
    sudo -s

    /etc/init.d/oracle-xe stop

    sudo ps -ef | grep oracle | grep -v grep | awk '{print $2}' | xargs kill

    sudo dpkg --purge oracle-xe

    sudo rm -r /u01

    sudo rm /etc/default/oracle-xe

    sudo update-rc.d -f oracle-xe remove
  


  Remove the following files that are no longer needed:


  
    sudo rm /sbin/chkconfig

    sudo rm /etc/sysctl.d/60-oracle.conf (may not exist)

    sudo rm /etc/rc2.d/S01shm_load
  


  Remove the lines previously added to the end of $HOME/.bashrc in Step P. This will prevent any warning messages about non-existent files from appearing when starting a shell.

  

  Remove the symbolic link to awk:


  
    sudo ln -s /usr/bin/awk /bin/awk
  


  Empty and then remove the /var/lock/subsys directory:


  
    sudo rm -Ir /var/lock/subsys

    sudo rmdir /var/lock/subsys
  


  
    BIO: Frank is the author of the book “Business Database Triage” and is currently working on the follow-up book, “Business Database Design – Class Notes from Aristotle’s Lyceum”.
  


  Write For Full Circle Magazine


  Guidelines


  The single rule for an article is that it must somehow be linked to Ubuntu or one of its many derivatives—Kubuntu, Xubuntu, Lubuntu, etc.

  

  Write your article in whichever software you choose—I would recommend LibreOffice. But, please spell and grammar-check it!

  

  The Official Full Circle Style Guide can be read at: http://url.fullcirclemagazine.org/75d471

  

  Please read this document before submitting an article. Follow the guidelines and you will have a much better chance of seeing your article in Full Circle.


  Writing


  There is no word limit for articles, but be advised that long articles may be split across several issues. In your article, please indicate where you would like a particular image to be. Please do not use any formatting in your document.


  Images


  Images should be no wider than 800 pixels, in JPG format, and use low compression.

  

  When you are ready to submit your article, please email it to: articles@fullcirclemagazine.org


  Non-English Writers


  If your native language is not English, don't worry. Write your article, and one of the proofreaders will read it for you and correct any grammatical or spelling errors. Not only are you helping the magazine and the community, but we'll help you with your English!

  



  FOR REVIEWS:


  Games/Applications

  When reviewing games/applications, please state clearly:

  • title of the game

  • who makes the game

  • is it free, or a paid download?

  • where to get it from (give download/homepage URL)

  • is it Linux native, or did you use Wine?

  • your marks out of five

  • a summary – with positive and negative points

  

  Hardware

  When reviewing hardware, please state clearly:

  • make and model of the hardware

  • what category would you put this hardware into?

  • any glitches that you had while using the hardware?

  • easy to get the hardware working in Linux?

  • did you have to use Windows drivers?

  • marks out of five

  • a summary – with positive and negative points

  

  You don't need to be an expert to write an article – write about the games, applications and hardware that you use every day.
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  A serious usage


  by Alessio Ciregia


  Disclaimer Maybe this article is not intended for a wide range of people reading this magazine, as I will describe the installation of a niche software related to the medical and health-care enterprise world.
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  I


  t is not a home software; indeed nobody has a positron emission tomography (PET) facility at home, have they?

  

  A serious world

  Maybe I’m wrong, but reading magazines like this, I have the feeling that Ubuntu, Linux and FOSS in general are mainly perceived, by common people, as something related to or useful for:


  
    	a hobby for geeks, computer enthusiasts and programmers


    	a free and legal way to achieve, using a PC, day by day personal interests (an alternative to Windows and paid software) and tasks such as:


    	
      
        	multimedia and amusement: games, image editing and video playback


        	personal and home income management


        	office software

      

    


    	and for professional use, it seems something strictly related to information technology, like something made by programmers for other programmers or IT staff:


    	
      
        	network tools


        	web server and stuff like that


        	programming languages and development tools


        	anything strictly related to IT, computer science, network and so on


        	and at last something related to business

      

    

  


  But there are other aspects of Linux and FOSS: the real world, the serious things. Like health care applications, as stated above.

  

  So, in this article I will explain how to install dcm4chee on Ubuntu. Maybe, as I said before, no reader of this magazine will have the need or the knowledge to install and understand this software, but if you are a student, or if you know a dentist or a radiological study, maybe you could be inspired by knowing the existence of this software.

  

  DICOM and PACS

  DICOM (Digital Imaging and Communications in Medicine) “is a standard for handling, storing, printing, and transmitting information in medical imaging”1.

  

  PACS (Picture archiving and communication system) is a medical imaging technology which provides storage of and access to images from multiple modalities2.

  

  A modality is a source machine where patient’s images are acquired from, for example, an X-Ray machine or a Magnetic Resonance scanner. Some other actors of a PACS are: servers, storage (NAS, SAN, tapes), printers, viewers, CD/DVD robots, etc.
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  dcm4chee (http://dcm4che.org/) is a DICOM archive and image manager, that is the server side of a PACS system, the server where medical images (an x-ray, an ultrasound, a magnetic resonance) will be stored, and from which a radiologist will retrieve your examination in order to carry out a medical report.

  

  “The application contains the DICOM, HL7 services and interfaces that are required to provide storage, retrieval, and workflow to a health-care environment”. It is written in Java and is prepackaged and deployed within the JBoss application server. It is open source and licensed under an MPL/GPL/LGPL triple license. There are also a lot of DICOM related tools provided by the same developers and community (called dcm4che toolkit), and some DICOM viewers, like Mayam, Oviyam and Weasis.

  

  If you need help and assistance there is a Google group where a vibrant and nice community will be willing to give you some advice. On the other hand, the wiki lacks a little bit in documentation, that is some pages are dated or are incomplete.

  

  Let’s install it

  Even if some willing person has packaged dcm4che in a “.deb” package3, and even if I’m a lover of package management systems, in this case I feel better if I install this software by hand.

  

  So, let’s see how to install dcm4chee on Ubuntu server 14.04 LTS.

  

  First of all we need to install Java. I’m not sure if dcm4chee works with OpenJDK. And I’m not sure if it works with Java 1.7, so let’s install Oracle Java 1.6, using a PPA repository.


  
    sudo apt-get install software-properties-common

    sudo add-apt-repository ppa:webupd8team/java

    sudo apt-get update

    

    sudo apt-get install oracle-java6-installer
  


  We need to accept the license, and so on.

  

  dcm4chee needs a database: Postgres, DB2, Oracle, MySQL, etc. If you want to try it without a RDBMS, you can opt for the HSQL package, but let’s install MySQL.


  
    sudo apt-get install mysql-server
  


  Now we need to create a schema and grant all rights to a user.


  
    $ mysql -uroot -p*****

    

    mysql> create schema pacsdb;

    mysql> grant all on pacsdb.* to pacs@localhost identified by 'pacs';

    mysql> flush privileges;

    mysql> \q
  


  Now we need to download JBoss and dcm4chee zip files. Download JBoss 4.2.3.GA (don’t use a newer version!) from http://sourceforge.net/projects/jboss/files/JBoss/JBoss-4.2.3.GA/jboss-4.2.3.GA-jdk6.zip/download

  Download the latest release of dcm4chee-mysql, 2.18.0 at time of writing, from http://sourceforge.net/projects/dcm4che/files/dcm4chee/

  

  Put the zip files in a temporary folder, like /var/tmp/dcminstall and unzip them


  
    sudo apt-get install unzip

    unzip dcm4chee-2.18.0-mysql.zip

    unzip jboss-4.2.3.GA-jdk6.zip
  


  Since we are on a 64-bit operating system, and the dcm4chee zip file contains a 32-bit version of compression library, we have to download the proper Java Advanced Imaging Image I/O Tools for linux 64-bit from http://download.java.net/media/jai-imageio/builds/release/1.1/ and replace the Linux version of libclib_jiio.so


  
    wget http://download.java.net/media/jai-imageio/builds/release/1.1/jai_imageio-1_1-lib-linux-amd64.tar.gz

    

    tar xzvf jai_imageio-1_1-lib-linux-amd64.tar.gz

    

    cp /var/tmp/install/jai_imageio-1_1/lib/libclib_jiio.so /var/tmp/install/dcm4chee-2.18.0-mysql/bin/native/libclib_jiio.so
  


  Now we have to copy files from JBoss to Dcm4chee:


  
    cd /var/tmp/install/dcm4chee-2.18.0-mysql/bin/

    ./install_jboss.sh /var/tmp/install/jboss-4.2.3.GA
  


  Now we have to import the provided SQL file in order to create the database tables and indexes:


  
    cd /var/tmp/install/dcm4chee-2.18.0-mysql/sql/

    mysql -upacs -ppacs pacsdb < create.mysql
  


  And now we have to move the dcm4chee directory to a definitive place, like /opt, and then it is useful to create a symbolic link (so, in case of an upgrade, we don’t need to modify any script or anything else pointing to the dcm4chee directory):


  
    cd /

    sudo mv /var/tmp/install/dcm4chee-2.18.0-mysql/ /opt/

    sudo ln -s /opt/dcm4chee-2.18.0-mysql /opt/dcm4chee
  


  It is a good idea to create a dcm4chee user and change the owner of the installation dir.


  
    useradd dcm4chee

    chown -R dcm4chee /opt/dcm4chee-2.18.0-mysql
  


  Now we can try to run dcm4chee in foreground:


  
    su - dcm4chee -c /opt/dcm4chee/bin/run.sh
  


  Using a web browser, connect to http://yourubuntuserver:8080/dcm4chee-web3 The default user is “admin” and the default password is “admin”. In order to make changes to the default configuration, we need to use the JBoss jmx console http://yourubuntuserver:8080/jmx-console/, and this task could be painful since there are no manuals covering a step-by-step configuration: you have to dig inside the wiki and on the old forum or, as I said before, you can call for help in the mailing list.

  

  More info:

  wiki - http://www.dcm4che.org/confluence/display/proj/The+Project

  mailing list - https://groups.google.com/forum/m/?hl=en#!forum/dcm4che

  discontinued forum - http://forums.dcm4che.org
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    BIO: Alessio is an unpretentious sysadmin at FTGM, a specialist cardiopulmonary health foundation in Italy. Linux and FOSS are not his hobby... they are a job. Sometimes he blogs at http://blogoless.blogspot.it
  


  Review

  AMD Catalyst 14.6 Beta for Linux


  by Oscar Rivera


  E


  ver since I first began using Linux, I've used proprietary drivers only when it was absolutely necessary. In fact, back then (during the release of Ubuntu 10.04 LTS), I noticed that the free open-source drivers worked better than the proprietary Nvidia drivers that my desktop needed at the time. About a year later, when I built a new computer, although I now had an AMD graphics card, I decided to stick with the open-source drivers instead of AMD's own drivers. Fast-forward a couple of years and another custom-built PC – to arrive at the present time, September 2014. A lot has changed in the last year, and it's mostly due to Valve's Steam video game engine being ported to Linux. I remember about two years ago when Linus Torvalds himself gave Nvidia a not-so-friendly hand-sign because of Nvidia's lack of cooperation with the Linux community.

  

  Ever since then, Nvidia has been making the effort to improve their relationship with us Linux folks. Nvidia's main competitor, AMD, didn't wait to get the finger from Linus in order to spring into action. AMD's Catalyst graphics drivers have lately been keeping up with the increasing demands of the new influx of games that are currently saturating the Linux market. As a gamer, I need to have the latest graphics drivers installed in my system. Ever since Valve's Steam video game engine strongly suggested that we use the latest proprietary graphics drivers for a smooth playing experience, I've been using the latest AMD Beta driver available through Ubuntu's Additional Drivers application (in Linux Mint the application is called Driver Manager). However, I've been aware that the latest Beta driver provided by Additional Drivers is NOT the latest AMD Beta available for installation.

  

  For this month's Video Game Reviews, I have been playing The Witcher 2: Assassin of Kings Enhanced Edition, which has perhaps the best graphics I've yet seen in a Linux video game. In order for me to play the video game ‘The Witcher 2’, it was suggested that I install the latest AMD Beta directly from the AMD website. My determination to play the video game drove me to figure out how to install it. I was pleasantly surprised to discover that the instructions on the website were pretty simple, straight-forward, and to the point. I downloaded the driver from: http://support.amd.com/en-us/kb-articles/Pages/Latest-LINUX-Beta-Driver.aspx

  

  I then followed the directions given on: http://support.amd.com/en-us/kb-articles/Pages/Catalyst-Linux-Installer-Notes.aspx

  

  Rather than turn this review into a How-To, I simply recommend that you pay attention to the instructions provided on AMD's website, and follow them as close as possible. Not only are the instructions easy to follow, but the actual AMD Catalyst Beta installer is also very user friendly, intuitive and makes it almost as easy to install as if you were using your distro's Software Center. I am very impressed with AMD's efforts to provide us with the latest drivers they have to offer. After a quick reboot, the new graphics driver should be working just fine. With the true latest AMD Beta 14.6 from the AMD website, I was able to play The Witcher 2 without any problems. The process of installing the AMD Beta Catalyst driver took less than 15 minutes and everything works better than before.
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  The only Con I find with using the AMD Catalyst Beta 14.6 is that it's a proprietary driver. On the other hand, there is a long list of Pro's. There is so much to gain from using this proprietary driver: it's easy to install, your games will play much better, and your desktop effects will look more impressive as well. I strongly recommend it to anyone who has an AMD Radeon HD 5xxx or newer graphics card, and is interested in playing the new flurry of video games that are trickling their way down into our beloved operating system.

  

  I give the AMD Beta 14.6 graphics driver 4½ out of 5 stars.


  
    Oscar graduated from CSUN, is a Music Director/Teacher, electronics beta tester, Wikipedia editor, and Ubuntu Forums contributor. You can follow him through Google+ at: www.gplus.to/7bluehand or email him at: www.7bluehand@gmail.com
  


  Linux Labs

  Compiling your own kernel for Ubuntu


  Part 2: Getting the source code


  by Alan


  I


  n the first part of this series, we saw what the Linux kernel is, and its place within a GNU/Linux operating system. We ended up by giving several reasons why a user of a modern operating system could still wish to compile his or her own kernel, centering our remarks specifically around the Ubuntu distribution. In this second chapter, we will consider the various ways of obtaining the source code for the kernel, explore its directory structure and see what other pieces we need in order to compile it.

  

  GETTING THE KERNEL SOURCE

  As usual with the Ubuntu distribution, the kernel source is available in a single software package from the command-line apt commands or your favorite graphical software manager. Basically, what we need to install is a single package, “linux-source”. This is a meta-package that points to whatever is the latest version of the kernel source in the repositories. So, in a terminal, go into administrator mode with:


  
    $ sudo bash
  


  and then refresh the package lists before downloading the kernel source. The refresh is important because kernel source packages do get updated from time to time, and the release version numbers can change.


  
    # apt-get update

    # apt-get install linux-source
  


  At the time of writing, the 3.13.0 kernel needed to download 97.7MB of files. This is installed as a single compressed file in directory /usr/src/linux-source-3.13.0 - or with whatever version number you have downloaded. Switch directories to there


  
    # cd /usr/src/linux-source-3.13.0
  


  and unzip the compressed file using the bunzip2 utility. The bzip compression algorithm gives better compression than the more common gzip, though at the expense of greater complexity. So do not be surprised if decompression takes some time!

  

  If it is not present on your system, you will first need to download and install the bzip utility programs:


  
    # apt-get install bzip2

    # bunzip2 linux-source-3.13.0.tar.bz2

    # tar xf linux-source-3.13.0.tar
  


  We should now have a subdirectory also called linux-source-3.13.0, into which we change directories once more:


  
    # cd linux-source-3.13.0
  


  It can be of help to create a direct link to the more recent kernel source tree, especially if we have more than one version:


  
    # ln -s /usr/src/linux-source-3.13.0/linux-source-3.13.0 /usr/src/linux
  


  and now /usr/src/linux points to the real directory at /usr/src/linux-source-3.13.0/linux-source-3.13.0. We can also do some cleaning up of the compressed files, if we need them no more.
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  An alternative way of getting the kernel source is to simply get it from the kernel.org project archives. This ensures that we get the very latest kernel version, and also that we have access to release candidates of the next, future, version. At the time of writing, Ubuntu's kernel source version is 3.13.0, but kernel.org has already gone up to 3.15.4, and the next version's release candidate is at version number 3.16.

  

  A word of warning may be appropriate, however: kernels that are not from the current stable version have not undergone the whole process of testing. They will include new features, and may possibly break your installation. If you do not need to test these future versions, it is best to stay with the stable ones.

  

  On the other hand, several older stable versions of the kernel source are also available at kernel.org; at the time of writing going back down to 2.6.32. It should be noted that these earlier versions have been updated with bug corrections and security updates since they came out; what is missing from earlier versions is merely the new features that have come out in newer versions.

  

  These older versions may come in handy, either to replicate the behavior of a system with an earlier configuration, or because a certain application needs a kernel from an earlier series. For example, an old hardware driver module available in source code may need a kernel source from the 2.0 series in order to compile correctly. These are probably fringe cases, however, and will rarely be seen by most users.

  

  Once downloaded, the compressed source file must be decompressed and un-tarred as with Ubuntu's packaged version. In this case, the tar file is compressed using XZ compression, a version of the popular 7-zip encoding from the Windows world. We will not need to install any further utility programs, tar itself can decompress this format. We can cd to wherever we downloaded the compressed file, transfer it to the /usr/src directory and uncompress it:


  
    # cp /home/alan/Downloads/linux-3.15.4.tar.xz /usr/src

    # cd /usr/src

    # tar xf linux-3.15.4.tar.xz
  


  This produces the linux-3.15.4 subdirectory, with the source files inside.

  

  DIFFERENCES BETWEEN SOURCES

  So far, we have obtained not one but two different kernel source trees. The first, from the Ubuntu repositories, contains the following structure:


  
    # cd /usr/src

    # ls linux


    
      
        
          	arch

          	Documentation

          	include

          	kernel

          	net

          	security

          	virt
        


        
          	block

          	drivers

          	init

          	lib

          	README

          	sound

          	
        


        
          	COPYING

          	dropped.txt

          	ipc

          	MAINTAINERS

          	REPORTING-BUGS

          	tools

          	
        


        
          	CREDITS

          	firmware

          	Kbuild

          	Makefile

          	samples

          	ubuntu

          	
        


        
          	crypto

          	fs

          	Kconfig

          	mm

          	scripts

          	usr

          	
        

      
    

  


  The second source tree, directly from the kernel.org project website, contains:


  
    # ls linux-3.15.4


    
      
        
          	arch

          	Documentation

          	init

          	lib

          	README

          	sound
        


        
          	block

          	drivers

          	ipc

          	MAINTAINERS

          	REPORTING-BUGS

          	tools
        


        
          	COPYING

          	firmware

          	Kbuild

          	Makefile

          	samples

          	usr
        


        
          	CREDITS

          	fs

          	Kconfig

          	mm

          	scripts

          	virt
        


        
          	crypto

          	include

          	kernel

          	net

          	security

          	
        

      
    

  


  So they are basically the same tree structure, with a single difference: the “ubuntu” subdirectory. This is not a surprise, since the Ubuntu package is supposed to come originally from kernel.org, though some re-packaging may have taken place. We can confirm this by looking at how much space is occupied by each version:


  
    # du -sh *

    626M linux-3.15.4

    634M linux-source-3.13.0
  


  Ubuntu's version is slightly larger – even though it contains an earlier kernel version. This confirms that Ubuntu has in fact altered the kernel in some way. The differences are what Ubuntu calls the “Ubuntu patches” to the kernel. The interested reader will find more information on Ubuntu's Kernel Team and what they do on their wiki page: https://wiki.ubuntu.com/Kernel

  

  EXPLORING THE SOURCE DIRECTORY STRUCTURE

  When we take a look at the source code directory tree, the first thing we see are several text files immediately at the tree root. As always, README is a great place to start. This file contains some quick instructions to get you up and running. However, some parts are slightly outdated, for example referring to the LILO boot manager that is little used nowadays, and not at all on Ubuntu distributions. The CREDITS and MAINTAINERS files contain a list of people who have contributed to the kernel code and some of the parts they have been responsible for. The perusal of these two files can give us a perspective of how the kernel is in fact the product of a team of programmers working together. Linus Torvalds and Greg Kroah-Hartman are perhaps the best-known participants and project leaders, but they are by no means alone.

  

  The Documentation directory is a large and not very well structured collection of mainly (very) technical notes. Most of the material here relates to specific hardware and procedures setup in the kernel, and unfortunately will be of little help to the beginner.

  

  The other directories are the kernel source code. The very basic stuff, mostly related to process scheduling and control, is in a directory named kernel. Other important parts are broken out into different directories: fs (file systems), ipc (inter-process communication), mm (memory management), net (networking), sound (sound drivers), etc.

  

  Several directories handle specific hardware needs. In the first place, the arch directory was created to contain low-level code to handle each type of architecture supported by the kernel. This is the only place where you should find assembly code instead of the C language. Having the very large majority of the code in C helps the kernel be adapted to different hardware platforms when needed: most C code will not need to be re-written, but simply compiled for the new physical architecture. On the other hand, each specific platform may need some very low-level coding just to take care of initial kernel booting. If you take a look in this directory, you will appreciate the diversity of hardware platforms supported by the Linux kernel. You will find not just the Intel 32-bit Architecture IA32 under x86 and AMD 64-bit architecture under ia64, but also well-known names such as alpha (the DEC Alpha processor), powerpc (the Intel-Apple-Motorola PowerPC), sparc (Sun's SPARC), and more modern architectures such as arm (the 32-bit ARM family used in tablets and phones) and even arm64 (the newer 64-bit version of the ARM).
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  Another important directory is drivers. Together with the sound directory (containing specific drivers for sound processing hardware) and several other minor directories, here is where you would see the drivers for each type of hardware the kernel supports. Basically, if there is code in this directory that knows how to handle your piece of hardware, it may work in a GNU/Linux system. Otherwise, things may get really complicated to get it to function.

  

  Please bear in mind that each piece of driver code in this directory does not address any particular brand or make of hardware, but rather the controller chips used in that device. For example, in directory drivers/net/ethernet/realtek we can find a file called 8139cp.c. This device driver handles any Ethernet network card using the RealTek RTL-8139C+ series controller, which at the time was used by many different card manufacturers, and sold under probably more than 100 different brand names. Some versions were used in exchangeable PCI-interface cards, while others were soldered directly into computer's motherboards. But all can use the same driver code developed initially (as was much of the network interface code) by Donald Becker, as is mentioned in the C file's initial commentary section.

  

  The firmware directory is the other place where we will find bits of code that are not written in the C programming language. A modern computer can in some ways be seen as a multicomputer network: the main computer hands off some of the work to daughter systems: the sound processing system, the graphics card, the network card, a hard drive, a printer, etc, are all formed by small computing environments, each controlled by a micro-controller acting as a small CPU in its own right. Firmware is a concept that comes from the introduction of non-volatile memory in both in domestic electronic apparatus and in internal computer components. These daughter systems now have the capability of running not only programs that were written once and for all in ROM chips, “engraved in stone” so to speak, but can also load programs on the fly into various forms of re-writable memory (EE-PROM or “Flash” memory). This memory on the daughter board contains programs in binary form, destined not for the computer's CPU but for the micro-controller of each apparatus or component.
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  To initialize and use some of these devices, we will need not only a device driver - which is a program run by our computer's CPU and resident in its own memory - but also a piece of firmware - known as a “binary blob” - that must be loaded into the device's memory on initialization. These are not considered as part of the kernel itself.

  

  There has been some dispute about the nature of the firmware included with the Linux kernel. Some distributions, such as Ubuntu itself, have little qualms about including firmware that is not open-source or released under the GPL license. Their take is that the end-user wishes simply to have things work; since they have acquired the hardware, they must also have access to the software necessary to make it function. But there is also the contrary standpoint, proposed notably by Richard Stallman and adopted by distributions such as gNewSense, that argues that proprietary and non-open binary blobs may work, or not. They may work particularly well in some cases, and fail miserably in others – and for reasons unknown. Since nobody except the manufacturer has access to the source code, there is no way of assessing the firmware code, making it better, or adapting it to new needs. It is for this reason that the kernel.org project members take pains to trace the origins of binary blobs distributed with the kernel, as may be seen in file firmware/WHENCE. It is also for this reason that distributions such as Ubuntu or Linux Mint permit the installation of certain non open-source drivers, but only at the user's initiative and specifying clearly they come without any support from the distribution's team.
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  WHAT ELSE DO WE NEED?

  Once we have the kernel source decompressed on our disk, we will need several things in order to compile it. Naturally, we will need the C language compiler, but that will not be all.

  

  For the readers who may need a quick primer on the process of compilation, let us begin by describing some concepts. In order to compile a program written in a compiled programming language, in the first place we will need the program itself, or what is called the source code. This is simply a text file that contains the program instructions, though the extension will have been changed to “.c” to mark it as a C source code file, and not a file containing mere text. We will now follow with a short example of a C program, contained in a file named “hello.c”. This is perhaps the best-known example of C programming, that almost all programmers will have seen at some point:


  
    #include <stdio.h>

    #include <stdlib.h>

    

    int main(int argc, char *argv[]) {

     printf("Hello, world!\n");

    }
  


  The first two lines indicate we wish to include several header files. These contain no code properly speaking, but just the definition of several function interfaces (such as “printf”). If we include them, the compiler will suppose these functions are available when reading in (“parsing”) our program file. The program's main body - the “main” function - contains just one single line, instructing the system to print a character string on screen. In order to actually execute this program, we will need to translate the complete program into an executable or binary file. This process is what is known as compilation.


  [image: ]


  Readers of Greg Walters' “Programming in Python” series in these very same pages will have noted that no such translation process is needed for the Python programming language. This latter belongs to the class of “interpreted languages”; the programs produced in an interpreted language are not executed directly, but rather interpreted instruction-by-instruction on the fly by a program called - you guessed it! - an interpreter. In the case of compiled languages such as C, however, no such interpreter exists, and so we need to convert the source code into an executable file before getting to test our program and knowing if it actually works.

  

  Both approaches have benefits and drawbacks. By using compiled languages, we get an executable file that can run very fast, and the end user will only need access to this single file. On the other hand, interpreted languages will give the end user access to the source code, which he or she can modify and tune to their needs. But they would need to have an interpreter for that particular language installed on their system, and the end result executes a tad more slowly.

  

  To compile our test “hello.c” program, supposing we have the gcc C language compiler installed on our system (if not, we will need to install package “gcc”), we can issue:


  
    $ cc hello.c -o hello
  


  This tells the C language compiler (“cc”, get it?) to compile source code file “hello.c”, producing executable file “hello”. Note that in the UNIX and GNU/Linux world, executable files need not have the “.exe” extension. Once the file is compiled, the resulting executable can be executed by issuing:


  
    $ ./hello

    Hello, world!
  


  Naturally, things can get a little more complex when a large application project contains several hundred C and header files. In the case of the Linux kernel, not all of these are always to be compiled – depending on which target architecture (Intel 32-bit Architecture, IA64, …) we are compiling for. To simplify things, a file containing instructions on what to compile, in which order, and using which compilation parameters, can be drawn up. This makefile can be seen as a pattern or guide for the compilation process.

  

  Going back to our sample program, we could write the file “Makefile” with the following contents:


  
    hello:

     cc hello.c -o hello
  


  Now, each time we wish to compile the file, we could use the make command to run the file contents for us:


  
    $ make hello
  


  and the corresponding instructions from the makefile would be executed.

  

  As you might suspect, both the compiler and the make-build environment are largely used in order to simplify the Linux kernel compilation process. This is why we will need to have installed not only the C compiler itself, but also several utility programs: GNU make itself, a bzip decompressor, etc.. The following packages will be needed at some point in the process:


  
    gcc binutils make bzip2 coreutils
  


  The kernel compilation process may be configured to a certain extent using the makefile system. To do so, several configuration scripts are available. The simplest, invoked by issuing:


  
    $ make config
  


  is a simple text-based script that needs no further software to work. However, the two graphical configuration utilities:


  
    $ make xconfig
  


  and


  
    $ make gconfig
  


  rely respectively on the qt and gtk widget frameworks developed originally for the KDE and Gnome desktop managers. In the first case, “xconfig” will need to have the following packages installed:


  
    qt4-default qt4-qmake
  


  If using the gtk version, “gconfig” will need packages:


  
    libgtk2.0-dev libglib2.0-dev libglade2-dev
  


  Finally, my preferred way of configuring the kernel is using the curses-based


  
    make menuconfig
  


  This text-based but more user-friendly environment will need the following package:


  
    ncurses-dev
  


  Now that we have all the bits and pieces we will need, in the next part of this series we will go through the available compilation options, and actually end up by compiling our first kernel.


  
    Author biography: Alan teaches computer science at Escola Andorrana de Batxillerat (high-school). He has given GNU/Linux courses at the University of Andorra and taught GNU/Linux systems administration at the Open University of Catalunya (UOC).
  


  Linux Labs

  Kodi/XBMC


  Part #1 - Hardware


  byCharles McColm


  [image: ]


  I


  t was way back in Issue #56 that I last wrote about XBMC for Full Circle Magazine. Back then, we were running XBMC on Ubuntu 10.04. We’re now a couple of Long Term Support (LTS) releases ahead. Back in Issue #56, our XBMC machine was a Dell Inspiron Mini 10 netbook (250GB internal hard drive) with a 1TB external hard drive for our media storage.

  

  Later we tried going even smaller, installing both the Android+XBMC and a custom firmware+Linux+XBMC distribution on a Pivos XIOS DS Media Play device. The custom firmware+Linux XBMC solution was wicked fast. The small device had lots of positives, built-in wireless, 3 USB ports, its own remote control, low power consumption, and it could be hidden behind our TV, but it had lots of drawbacks too. The minimal version of Linux for the XIOS DS lacked some of the flexibility we had on the Ubuntu Linux + Inspiron Mini 10 solution. Storage was minimal (we had a small microSD card). Adding more storage meant either connecting an external hard drive or setting up a NAS somewhere (more power and cables). And we wanted a bit more CPU power!

  

  Coincidentally, about this time the 1TB hard drive started displaying SMART errors so we bought a 2TB hard drive. The larger hard drive triggered our desire to go bigger and badder so we added a bit more equipment:

  

  An Antec Sonata II case, an Asus P5K SE motherboard, an Intel Pentium D processor at 3GHz with 4GB of RAM, and a 320GB hard drive for the boot drive.

  

  For a short time we used the same solution we used for the netbook – a VGA cable and a separate sound cable to hook up to our 42” Samsung LCD Television. We’re fortunate that our LCD television supports VGA as well as HDMI. One of the nice things about the Pivos XIOS DS setup was the fact that both the audio and video went over the HDMI cable to our television. We like things nice and tidy and using the VGA cable meant we had to run a second cable for audio.

  

  A couple of weeks later we picked up an NVidia GeForce 210 1GB video card. We got the card on an open box special. The sales person cautioned us that the card was meant for multimedia, not gaming. We just smiled and took the generous discount. The card has 3 common video connections: VGA, DVI and HDMI. Only HDMI supports video and audio.

  

  Around the same time the XBMC project released a version of Ubuntu+XBMC called XBMCbuntu. XBMCbuntu simplified a lot of things we had to install manually before (it installed proprietary video drivers, SAMBA, already had support for our Windows Media Centre remote control - which works nicely if you use lircd, etc.). XBMCbuntu came in an AMD and an NVidia flavour. It worked very well except for the fact that it failed to get the correct Extended Display Identification Data (EDID) for our television. XBMC displayed just fine at 1920x1080 (over the HDMI cable, the VGA cable we originally used limited us to 1366x768) but if you quit XBMC and ran the underlying Openbox you could barely read anything on the screen.

  

  Several software upgrades later we managed to get XBMC to version 13 (Gotham) but because we used XBMCbuntu we were stuck with Ubuntu 12.10. With Ubuntu 12.10 sorely out of date and XBMC heading towards release 14 and it’s new name, Kodi, we decided it was time to upgrade and change again.

  

  The argument for the Kodi name was partly rooted in the fact that XBMC doesn’t run on any XBox other than the original machine (and barely at that). While we’re not aware of Microsoft exercising any trademark infringement actions against the XBMC team, the possibility was always there. Over the years XBMC has become much more than just a media centre, it streams, it can game, and can be a PVR front end. The Kodi name change is part of a larger move towards changing the XBMC image from just a media centre to an entertainment centre.

  

  All this newness lead us to realize our XBMC machine is a bit of a dinosaur – outdated software, and hardware we’d been using for quite a long time. Ideally we would have used something like this:http://ca.pcpartpicker.com/p/8KFm23

  

  For our ideal build we went Intel over AMD because our experience with NVidia for video drivers is generally better than AMD, but it’s worth noting here that last year we built an AMD APU-based system that has worked wonderfully as a desktop system using Kubuntu and Xubuntu. That system had the following parts (plus a 250GB hard drive and a Blueray player we already had):http://ca.pcpartpicker.com/p/bGvDnQ

  

  The PC Part Picker web site is a handy way to piece together a system for do-it-yourselfers and has a US and UK version, just add us or uk in front of the url (uk.pcpartpicker.com for example).

  

  Our budget was a lot less than $900 (the Intel system), and we could get some used upgrades we could trust for a lot less. So we started by upgrading parts and including one of the parts in our list, the 3TB hard drive.

  

  The first change: Our aging Pentium D processor. Changing motherboards would have meant investing in a new motherboard, CPU and DDR3 RAM. What we had with our Socket 775-based motherboard was working well for us. We just wanted to squeeze a bit more power out of the system, so we picked up an Intel Core 2 Quad Q8300 @ 2.50GHz (4 Cores) processor. Our original Pentium D clocked in a bit quicker at 3GHz, but after changing to the 4 core Q8300 we noticed the movies scrolled by better on the selection screen. It was a noticeable difference.
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  Next we focused on our 2TB data hard drive. The drive was more than half full and we’d recently moved a bunch of data on to the 320GB operating system drive to free up more space, so we picked up an inexpensive 3TB Seagate drive.

  

  Both the operating system drive and the 2TB hard drive are Seagate drives. And while our first Seagate 1TB started showing smart errors after about 1 year the 2TB and 320GB drives have run well for a couple of years.

  

  The new drive posed a bit of a problem because we’re using older hardware that doesn’t natively support GPT in the BIOS. Linux does support GPT, but it took some poking around to figure out how to partition and mount the drive.

  

  Initially we tried setting up the drive using: cfdisk /dev/sdc. Cfdisk seemed to see all 3TB and when we formated the drive it appeared like it was going to get detected as 3TB, but when we rebooted we noticed it showed up as 768GB, a fraction of the size. We kept looking and found a solution on Buildcube:http://www.buildcube.com/tech_blog/2012/07/25/installing-my-3tb-hard-drive-on-debian-linux-step-by-step/

  

  Initially we were a bit crazy and formatted our drive using NTFS. The 2TB hard drive was already NTFS so we thought we’d do the same for the 3TB, but later we decided against it and went ext4. It’s worth noting that we found ext4 took up less space – 77MB versus the 160MB NTFS used. We’re including both methods here.


  
    sudo apt-get install parted

    sudo parted /dev/sdc
  


  The previous command puts us in parted. Parted is a bit like the ex editor, it waits for us to give it commands. We’ll give it the command to make a GPT label instead of an MBR label (2TB max).


  
    mklabel gpt
  


  Answer yes to the warning that data will be destroyed (assuming your drive was /dev/sdc -- ours actually was), don’t accidentally delete a drive/data you need.


  
    mkpart primary ntfs 0% 100%

    quit
  


  This sets up the drive as gpt and gets it set for formatting, now we just need to format the drive:


  
    sudo mkfs.ntfs -Q /dev/sdc1
  


  The -Q in the NTFS version does a quick format. If you don’t use the -Q switch and go NTFS, expect to wait a long time.

  

  At this point we stopped being silly and repeated the process with the following modifications to make the drive a writable ext4 drive:


  
    sudo parted /dev/sdc

    mklabel gpt

    mkpart primary ext4 0% 100%

    quit

    sudo mkfs.ext4 /dev/sdc1
  


  One of the problems we ran into when we mounted our new ext4 drive was that we couldn’t get it writable by the xbmc user account. Permissions are always fun. To fix the problem, we created a directory under /mnt called /mnt/movies and changed the owner to the xbmc user:


  
    sudo chown -R xbmc.xbmc /mnt/movies
  


  The period between the xbmc’s differentiates user and group, so if you wanted a different group you would issue chown with something like sudo chown -R xbmc.multimedia /mnt/movies.

  

  Now we needed to get our new hard drive into /etc/fstab so it would be mounted automatically. Several years ago the mounting method in /etc/fstab switched to UUID’s making it a bit more complex; luckily we have blkid to tell us the UUID of each drive. We simple ran:


  
    sudo blkid
  


  Our results looked like this:


  
    /dev/sda1: UUID="9ce53713-9bcd-4df4-a160-e93826eefb2f" TYPE="ext4"

    /dev/sda5: UUID="db9cf246-0e50-4a95-bec0-6ad63e91e20d" TYPE="swap"

    /dev/sdb1: LABEL="data" UUID="4D07684A289AEA37" TYPE="ntfs"

    /dev/sdc1: UUID="a6732b72-ef69-4129-88e6-ed328d8c8786" TYPE="ext4"
  


  The line we added to /etc/fstab was:


  
    UUID=a6732b72-ef69-4129-88e6-ed328d8c8786 /mnt/movies ext4

    defaults,noatime 0 1
  


  If we were doing NTFS, it would have been something like (note the UUID changes when formatted with NTFS:


  
    UUID=1011D1F75957D63A /mnt/movies ntfs errors=remount-ro 0 1
  


  To test our entry was working correctly, without rebooting we mounted all the drives in fstab:


  
    sudo mount -a
  


  Then we ran df -hH to see the sizes:


  
    Filesystem Size Used Avail Use% Mounted on

    /dev/sda1 311G 31G 266G 11% /

    udev 2.2G 13k 2.2G 1% /dev

    tmpfs 424M 697k 423M 1% /run

    none 5.3M 0 5.3M 0% /run/lock

    none 2.2G 4.1k 2.2G 1% /run/shm

    none 105M 0 105M 0% /run/user

    /dev/sdb1 2.1T 1.2T 834G 59% /data

    /dev/sdc1 3.0T 77M 2.9T 1% /mnt/movies
  


  Success! We kept our initial install of XBMCbuntu temporarily so we could focus on the hardware.

  

  Hardware-wise we were (almost) done for now. Next issue we’ll be installing Linux+XBMC and all the services for remote control support and sharing within the house. But, just before we close, one final hardware change we made was to upgrade our home network a small bit. Since we would be moving large files (one 3-hour movie in Blueray-quality was around 12GB), we added a gigabit switch to our internal network to speed things up a bit.
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  Before mounting all the networking equipment we took pieces of paper and outlined each piece of equipment and their mounting holes. We then taped those outlines to the mounting board and put screws in the place each piece of equipment would mount. In the case of our small VOIP box, we needed to run hanging wire across it to keep it in place because it intended to sit on top of something rather than be mounted on a wall.

  

  Next issue, the Linux and XBMC install.


  
    Charles McColm is the author of Instant XBMC, a short book on installing and configuring XBMCbuntu (a *buntu+XBMC distribution), and the project manager of a not-for-profit computer reuse project. When not building PCs, removing malware, and encouraging people to use GNU/Linux, Charles works on reinventing his blog at http://www.charlesmccolm.com/.
  


  My Story


  by Kostas Kotoulas


  T


  aking advantage of your call for personal stories, I'm sending you mine. It was back in December 1997, when I was on my mandatory 18-month tour in the Army (I'm Greek and still to this day there is a mandatory tour for all Greek males, although it's 9 months now). During a training break, I was talking with another guy who had, prior to his tour, finished his master’s in Computer Science from a university in the USA (don't recall which). We were talking about the impact the then new Windows 95 had on PCs, and I was whining because I still owned a 486DX/33MHz PC which couldn't run Win 95.

  

  So he said "try Linux". "What's that?" I asked (intrigued by the very name). He started to talk about it, mentioning how it is a Unix-like OS (I had previous experience with Unix on a VAX machine back in my university years), very light, and that my humble hardware would be perfect for it.

  

  On my next leave, I went to a friend who was still in the university (back on those days only universities had good internet access in Greece, dial-up connections were still at 14400 bps), and downloaded a distro in about 8 or 9 floppies. I think it was Slackware or Debian, not sure. Got home, did the installation, and a couple of hours later—through an agonizing 2nd install because of mistaken configurations—I saw a login screen! It took me all three days of my leave to read just the essential texts to get some idea but that was it: I was hooked for life.

  

  Although because of work (I'm a computer technician), I was forced to have a Windows machine at home, I always used a GNU/Linux OS on my old hardware; at the start an Athlon XP 2000, later a P4/3.0GHz; but since I got laid off (damn Greek Crisis) three years ago, I use a GNU/Linux OS on my main PC too. I have used Slackware, Debian, Suse, openSuse, Mint, Redhat, Fedora, Mandrake, Mageia. and, of course, Ubuntu. Usually I had two or three distros at a time on different hdds for comparison. Although Debian is still my favorite flavor, I really love Ubuntu's LTS versions and I think they are the best distro a beginner can use because of the fact that you will use roughly the same version for two, maybe three, years—enough time for a beginner to become an advanced user. I think that the features of Ubuntu that beginners really like are the easy update process, the fact that the root account is locked—leading to fewer mistakes for an inexperienced user—and the vast number of applications available.


  Tuxidermy
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  ﻿Q&A


  By Gord Campbell


  
    	Q I accidentally deleted the indicator-applet when trying to remove another applet in the taskbar. When logging in as another user everything is as it should be. What do I have to do to make this applet re-appear on my taskbar?


    	A (Thanks to ibjsb4 in the Ubuntu Forums) Alt-right-click, Add to panel, choose indicator applet.


    	



    	Q I just started using Ubuntu, I want to install Eclipse CDT.


    	A Open Software Centre, search for Eclipse CDT, click on Install. It's pretty different from what you are used to.


    	



    	Q I am using the Gnome 3 desktop on Ubuntu 14.04. I use two monitors. I can reset them to the correct positions using nvidia xserver or the display setting, but they stay the right way round only until the next reboot.


    	A (Thanks to bizhat in the Ubuntu Forums) When Nvidia xserver gives the option to save the changes, save them in xorg.conf in folder /etc/X11


    	



    	Q Is there a software solution for updating a Linux server with no internet?


    	A You can use apt-offline.


    	



    	Q I have installed the drivers for [some program] in WINE, but it doesn't work.


    	A (Thanks to Vladlenin500 in the Ubuntu Forums) No, certainly not. WINE runs SOME Windows apps. It doesn't (it can't) work with drivers.


    	



    	Q I accidentally sent a print job to a printer I no longer own. Now I get a message popping up, saying there is a problem. How can I make it stop?


    	A You need to clear the print queue. To see what is in the queue, use the command: lpq To clear the queue, use the command: cancel -a


    	



    	Q How can I have a few confidential files stored in an encrypted folder?


    	A Use encfs, with its front-end program called Cryptkeeper. In the Ubuntu Forums there is a tutorial created in 2006 which is still relevant today. (Google: encfs ubuntuforums) There are also online tutorials for Cryptkeeper, which shows up as an icon on the taskbar.


    	


  


  Top questions at Askubuntu


  * Find out the application under the mouse

  http://goo.gl/HPrtdZ

  

  * flashplayer not working in Chromium

  http://goo.gl/PQpfD4

  

  * AVG antivirus not working

  http://goo.gl/hs0LPz

  

  * HDMI audio not working on TV

  http://goo.gl/TfMCzh

  

  * No GRUB Screen or recovery mode on Boot after 12.04 Upgrade

  http://goo.gl/PlRHOy

  

  * Can I see in a log file all GUI based tasks in its alternative command-line format?

  http://goo.gl/gxkh5k

  

  * Problem accessing Windows Share from Ubuntu using Samba

  http://goo.gl/KNWwt6

  

  * An Ubuntu command bricked my system?

  http://goo.gl/93aSrk

  

  * Is it okay to use symbolic links in my web server?

  http://goo.gl/VXbXBghttp://goo.gl/VXbXBg


  Tips and Techniques


  Like a fine wine, it gets better with age.

  

  A five-year-old Acer Aspire One netbook recently fell into my lap. It had Windows XP installed, which is not acceptable in my home or office, so I decided to give Xubuntu 14.04 a spin.

  

  The specs for this little computer are not impressive. The 8.5-inch (diagonal) screen resolution is 1024 by 600, roughly one-quarter of the size and resolution of my Dell Ultrasharp monitor. The keyboard is shrunken by 10%, and some of the keys are in unusual locations. The CPU is a single-core, 32-bit Atom N270 running at a maximum of 1.6 GHz. The machine has a gig of memory and a 160 GB hard drive. There are three USB 2.0 ports, an Ethernet port, VGA and audio ports, Wi-Fi and a low-resolution webcam.

  

  On the positive side, the five-year-old battery will run the computer for over two hours, and it appears to be quite physically robust. It's also small and light, compared to a typical laptop.

  

  I remember browsing the forums when this computer was new, and there were lots of people asking, "how do I get such-and-such working." Installing Xubuntu was slow, but it went very smoothly. When I booted the installed system, everything just worked!

  

  There was one puzzle for me: the installed system knew about a printer which was not connected to any computer at the time, nor was it plugged in. Huh?

  

  Xubuntu doesn't include a webcam program, but guvcview installed easily and just worked.

  

  I installed lm-sensors, hddtemp and conky. One benefit of the low-powered CPU: it never gets very hot. I was very surprised by how little memory is used when the system boots up.

  

  The computer plays youtube videos just fine, although I'm sure it's dropping lots of frames.

  

  After installing Samba, I could access shared folders on the network, and eventually set up a shared folder on the netbook. Under Xubuntu, it was no easier than setting up a shared folder in Ubuntu Server, with no GUI. (See last month's Q&A).

  

  I installed x11vnc so I could control the computer remotely, using KRDC in Linux, or RealVNC in Windows. That meant I could use the machine as a remote camera, as well as a small file server.

  

  The small screen and slow CPU make this far from my favorite computer. However, free Wi-Fi is available everywhere these days, and the portability makes this a viable option for when I'm out and about.


  Games

  The Witcher 2: Assassins of Kings Enhanced Edition


  Oscar Rivera


  T


  he Witcher 2: Assassins of Kings Enhanced Edition has recently become available for Linux and I'm happy to report that it plays well. The Witcher 2: Assassins of Kings Enhanced Edition is an action, role-playing video game developed by CD Projekt RED and published by Warner Bros. (Note that only the Enhanced Edition is published by Warner Brothers). The game was originally released in May 2011 for Microsoft Windows, with a follow-up release in 2012 for Xbox 360. Although it was released for Linux early in Summer 2014, it wasn't until mid-August that I was able to play it without any crashes or glitches on my Ubuntu desktop. The Witcher 2: Assassins of Kings Enhanced Edition is undeniably one of the best additions to the rapidly growing Linux video game library.

  

  When I found out that The Witcher 2: Assassins of Kings Enhanced Edition had become available for Linux, I felt like a kid on Christmas morning. I immediately went to the Steam Store to buy the game, but I first looked up the Minimum and Recommended System Requirements for the game before making the purchase. Not to my surprise, I found out that my graphics card was not listed. In fact, only Nvidia graphics cards were listed; no AMD or Intel graphics cards were supported. According to the System Requirements at the time, you needed to have a GeForce 9800 GT 512MB or better AND it specifically said:

  

  We recommend the following drivers:

  nVidia - nvidia binary driver 331.79 or later

  MESA based drivers (e.g. "nouveau") are not currently supported.

  Intel integrated graphics are not currently supported.
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  What a bummer! Even though I had a more than capable graphics card, I wasn't able to play the game. After continuously checking on the Steam Forums and The Witcher 2 Steam Store page, three weeks later I finally saw that other Linux gamers had been successful in playing The Witcher 2 with AMD graphics cards. I went through the trouble of installing AMD's Catalyst 14.2 Beta graphics driver from AMD's website and successfully played the game on my computer. Apparently, AMD acknowledges that there is a substantial enough amount of Linux users to maintain Linux drivers as current as Windows and Mac drivers. Things are definitely changing for the better in the Linux gaming world and it is affecting desktop Linux as a whole.

  

  The Witcher 2: Assassins of Kings Enhanced Edition was well worth the hassle and the wait. As soon as I started playing the game I was instantly hooked. The main character, Geralt of Rivia, an undead mutant, is the title's witcher, who uses swords and sorcery as part of his combat repertoire. The game-play is very smooth from the beginning and improves as the game progresses. The graphics are phenomenal throughout the game but especially stunning during the cinematic cut-scenes. Often, while being absolutely captivated by the striking animation and the intricacies of the plot-line, you are suddenly thrown into intense combat situations which require quick reflexes in order to stay alive. The storyline, rich in magic, politics, romance, revenge and fantasy, is a little hard to follow at first but it doesn't take long for it to start making sense as the game gets going. As an RPG, the story takes different paths depending on your decisions made while in dialogue with other characters. The voice-acting dialogue is superb and accordingly fits the wide variety of characters you encounter in the game. The character development portion of the game is not to be taken lightly as it has a very direct effect on game-play and each point should be spent on abilities that will enhance your playing style.

  

  Perhaps my only complaint about this game is the ridiculously short and seemingly incomplete tutorial at the beginning of the game. It seems like you have just started playing the game when the tutorial ends and you are left to play the game with less than 25% of knowledge of your full capabilities. Saying that The Witcher 2 has a steep learning curve at the beginning is an understatement. I had to re-play the tutorial a couple of times before realizing that I'd be better off looking for help elsewhere, like for example ign.com. I first played using my keyboard/mouse because I couldn't get my Razer gamepad controller to work; besides, the game was originally released for PC and later for the Xbox360 game console, so using the keyboard/mouse is how it was meant to be played. After looking for help in the Steam forums, I was able to get my controller to work for this game. In the process, I noticed the high level of commitment given to the game's Linux port as evidenced by one of the developer's efforts to get my controller to work.
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  Minimum System Requirements:

  OS: Ubuntu 12.04 LTS, Steam OS

  Processor: Intel Core 2 Duo

  Memory: 4 GB RAM

  Graphics: GeForce 9800 GT 512MB (1280x720, low)

  Hard Drive: 25 GB HD space

  

  My Gaming Setup

  I played The Witcher 2: Assassins of Kings Enhanced Edition with my custom made desktop PC consisting of an AMD FX-6100 3.3GHz CPU, an Asus M5A97-EVO motherboard, a Sapphire Radeon HD 5770 graphics card, 8GB of Kingston Hyper X RAM, and a 1TB Seagate Barracuda hard drive. The software used was Ubuntu 14.04 LTS with Unity and AMD 14.2 Beta Catalyst proprietary graphics driver.

  

  Conclusion Pro's


  
    	Stunning detail, deeply textured scenery, amazing cinematic cut-scenes make the graphics in this game some of the best I've ever seen for any game.


    	Multi-accented voice-acting breathes life into each of the many diverse characters.


    	Politically intriguing plot with shades of magic and a touch of romance teleports you into a medieval fantasy that keeps you at the edge of your seat wondering what will happen next.


    	The role-playing genre is taken to new heights with The Witcher 2's radically different consequences highly dependent on your choices.


    	Easy to navigate, once you get the hang of it, whether you use keyboard/mouse or a controller gamepad.

  


  Con's


  
    	Tutorial is much too short and may as well not even exist for all it teaches you.


    	Proprietary graphics drivers REQUIRED to play this game.

  


  All in all, this is one of the best games I've ever had the pleasure of playing. If you don't mind using proprietary graphics drivers in your system and you're into action-adventure, role-playing games, then spend the $19.98 that Steam is asking for this game.

  

  I give it 4½ out of 5 stars.


  
    Oscar graduated from CSUN, is a Music Director/Teacher, electronics beta tester, Wikipedia editor, and Ubuntu Forums contributor. You can follow him through Google+ at: www.gplus.to/7bluehand or email him at: www.7bluehand@gmail.com
  


  Ubuntu Games

  X-Plane 10


  by Ronnie Tucker


  O


  nce upon a time, Microsoft Flight Simulator was ‘thee go to’ flight simulator. Nothing could touch it. Then came along free equivalents such as flightgear. Creeping up behind them was X-Plane – a far more sophisticated flight sim that really did what a flight sim should do. It took the model, and applied physics to it, and at that point you really were an X pilot – testing out unknown planes. Microsoft’s effort has since fallen by the wayside. It never truly simulated a model plane in physics. Every plane model needed botches to make it seem right, and as of Flight Simulator X it hasn’t been updated. X-Plane, on the other hand, has matured nicely and is, as of writing, at 10.2 with 10.3 in beta.
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  The problem with X-Plane was that it was huge. And I mean massive. It came spanning almost a dozen DVDs and was available only as a physical object. The makers have changed that now by having X-Plane available to download via Steam. And about time too! The download is not for the faint of heart. My install of just X-Plane 10 and the European scenery is around the 8GB mark. Downloading the rest of the world will get you a grand total of 80GB.

  

  Getting Started

  

  Once your download is complete, you can start X-Plane and get the quick-start window. It’s ironic that they call it the ‘quick flight’—getting to that window took a full two minutes on my Quad Core 2, 8GB RAM machine! Once there, you quickly choose a plane from the default list, a location (airport), and a weather type. To get into the pilot’s seat takes a further three minutes of loading time. You start on the runway with the engine running ready for take off.
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  You can, if you wish, move your mouse to the top of the screen to access the menu and bring up the location map. This shows you, and some AI planes, on the map. From here, you can see some basic airport info (radio channels, etc), and also the ability to toss your plane into the sky at an altitude/speed of your choosing. You can also choose from the preset buttons to have your plane in the sky heading for a landing. Handy for practice. Something you’ll need.
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  How On Earth Do I…

  

  Inevitably, you’ll be sitting there in the cockpit not having a clue what to do. X-Plane does come with a manual (don’t worry it’s only 185 pages), but it’s pretty generic as every plane has a different cockpit and features that are unique to that plane. You can quickly learn to fly a single engine Cessna, but that won’t help you a jot if you load up a monster 737/747. Sure, you’ll know the basic dials, but everything above a Cessna may need a knowledge of the flight computer (FMC) or a knowledge of waypoints and flight plans. It’s all heady stuff and a lot to take in. From my short time (thus far) of using X-Plane I’ll give you this piece of advice: remember, it’s a simulator. If you want to know something, look at the real-world. Watch videos on YouTube of actual flights. What you see in real life is what you need to do in X-Plane.
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  Scenery And Add-ons

  

  While X-Plane looks OK in the graphics department, I recommend you install some scenery packs. X-Plane has the locations (eg: Glasgow Airport), but it looks nothing like the real thing. This can be fixed by using add-on scenery. Similarly, while it does have Glasgow, it looks nothing like Glasgow does in Google Maps. This is rectified by using more add-ons. Once you have a couple of these installed, your X-Plane will look fantastic. If your PC can handle it that is.
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  There are a myriad of add-ons; realistic sky/clouds/weather, aircraft, online ATC, the list goes on.
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  Controls

  

  I use a Mad Catz FLY 5 stick which works excellently with X-Plane. Thankfully, X-Plane is highly configurable. In the Joystick/Buttons menu, you have complete control over the configuration – by pressing a button on your stick and then choosing which feature it should control. It does, of course, allow tweaking of joystick sensitivity and joystick calibration. Further in-depth configuration can be done using plugins, but I’ll talk more about that next month. Hint: it involves using a webcam to look around your 3D cockpit.

  

  Conclusion

  

  Make no mistake about it, this is not a game. This is a simulation with so much to learn that it’s quite frightening, but don’t let it get to you. You can treat this as either a friendly simulator (ie: quick flight, no ATC, A to B), or as a full-on sim (ie: get a flight plan online, use real-time online ATC, use auto-pilot, etc) – it’s entirely up to you.

  

  While I definitely have a longer list of CONS than PROS for this review, I still think X-Plane is a fantastic piece of software. Yes, it may seem expensive (£44.99 as I write this), but it has a ton of add-ons and plugins – most of which are free. I do have to deduct a star for its long loading time; it really is unforgivable and something that I hope will be fixed. The other downsides can easily be fixed with free add-ons/plugins.

  

  Next month, I’ll show you how to install the free Python installer plugin (that allows you to run Python scripts in X-Plane), then use it to show your plane’s real-time position on a map. But we’ll save that for Foxtrot, Charlie, Mike, niner, zero.

  

  Rating: 4 out of 5

  

  X-Plane 10 requires, at the minimum,

  Dual Core, 2.5 GHz or faster

  2 GB of RAM

  A video card with at least 500 MB of VRAM.

  

  PROS:


  
    	Looks gorgeous when you have additional scenery installed


    	You can effectively download the entire world’s landscape


    	Plugin architecture allows for more planes/scenery/features

  


  CONS:


  
    	Text to speech Air Traffic Control doesn’t seem to work in Linux


    	Can’t easily do multi-monitor cockpit display


    	Some plugins aren’t Linux compatible (eg: SkyMaxx for improving skies)


    	Landscape is a bit bland and lacks detail (can be fixed with addons)


    	Locations and airports aren’t always based on fact (again, can be fixed with addons)


    	Extremely steep learning curve as every plane is different


    	Some cockpits are quite blurry on closer (3D) inspection


    	Takes far too long to load


    	Download size can be anywhere from 8GB to 80GB depending on what parts of the world you want installed


    	Could be considered quite expensive for a ‘game’


    	Takes a hefty machine to run the game with detailed scenery, buildings, shading and traffic.

  


  For help and addons: http://forums.x-plane.org/

  

  Plane used in the screenshots is the Eclipse 550: http://forums.x-plane.org/index.php?app=downloads&showfile=18661

  

  Google Maps based scenery: http://simheaven.com/


  My Desktop
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  This is the beta version of Elementary Freya (32-bit version) I am testing on an Acer Aspire One (1.6 GHz Intel Atom). The user interface is the way I like them: minimalistic, functional and elegant. Gtk3 libraries work as expected, with desktop effects present but low-key. There is not much installed on this low-powered machine: just the Chromium browser to access Google Drive, a file-browser and, of course, the command-line terminal.

  

  I am very pleased with the general feel and look of the UI, although processor and memory use are way higher that they should be. This *is* a beta version, after all. I am waiting for the final product to come out, then will surely adopt it.

  

  Alan Ward
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  I am using a computer with Xubuntu operating system. I use a netbook Axioo Pico W217CU that has a relatively small display, only 10 inches. However I wanted to have a large workspace, and therefore made the panel in deskbar mode. Then I made a more transparent panel and I set it to autohide. I am using a numix desktop theme, numix circle icon theme, and conky with a standard theme. These themes give me more freedom to work with my computer.

  

  muksidin Emoox


  Contribute to Full Circle Magazine

  FULL CIRCLE NEEDS YOU!


  A magazine isn't a magazine without articles – and Full Circle is no exception. We need your opinions, desktops, stories, how-to’s, reviews, and anything else you want to tell your fellow *buntu users. Send your articles to: articles@fullcirclemagazine.org.

  

  We are always looking out for new articles to include in Full Circle. For help and advice, please see the Official Full Circle Style Guide: http://url.fullcirclemagazine.org/75d471

  

  Send your comments or Linux experiences to: letters@fullcirclemagazine.org

  Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org

  Questions for Q&A should go to: questions@fullcirclemagazine.org

  Desktop screens should be emailed to: misc@fullcirclemagazine.org

  ... or you can visit our forum via: www.fullcirclemagazine.org

  

  Full Circle Team:

  Editor - Ronnie Tucker - ronnie@fullcirclemagazine.org

  Webmaster - Rob Kerfia - admin@fullcirclemagazine.org

  Podcast - Les Pounder & Co. - podcast@fullcirclemagazine.org

  

  Editing & Proofreading:

  Mike Kennedy

  Lucas Westermann

  Gord Campbell

  Robert Orsino

  Josh Hertel

  Bert Jerred

  

  Our thanks go out to Canonical, to the many translation teams around the world, and to Thorsten Wilms for the current Full Circle logo.

  

  Getting Full Circle Magazine:

  

  EPUB Format - Most editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with the epub file, you can drop an email to: mobile@fullcirclemagazine.org

  

  Google Currents - Install the Google Currents app on your Android/Apple devices, search for 'full circle' (within the app), and you'll be able to add issues 55+. Or, you can click the links on the FCM download pages.

  

  Ubuntu Software Centre - You can get FCM via the Ubuntu Software Centre: https://apps.ubuntu.com/cat/. Search for 'full circle', choose an issue, and click the download button.

  

  Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to spread the word about FCM and Ubuntu Linux.
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